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Introduction

The pivot table is the single most powerful tool in all of Excel. Pivot tables came along 
during the 1990s, when Microsoft and Lotus were locked in a bitter battle for domi-
nance of the spreadsheet market. The race to continually add enhanced features to their 
respective products during the mid-1990s led to many incredible features, but none as 
powerful as the pivot table.

With a pivot table, you can transform one million rows of transactional data into a 
summary report in seconds. If you can drag a mouse, you can create a pivot table. In 
addition to quickly summarizing and calculating data, pivot tables enable you to change 
your analysis on the fly by simply moving fields from one area of a report to another.

No other tool in Excel gives you the flexibility and analytical power of a pivot table.

What you will learn from this book

It is widely agreed that close to 60 percent of Excel customers leave 80 percent of Excel 
untouched—that is, most people do not tap into the full potential of Excel’s built-in utili-
ties. Of these utilities, the most prolific by far is the pivot table. Despite the fact that pivot 
tables have been a cornerstone of Excel for almost 20 years, they remain one of the most 
underutilized tools in the entire Microsoft Office suite.

Having picked up this book, you are savvy enough to have heard of pivot tables—and 
you have perhaps even used them on occasion. You have a sense that pivot tables pro-
vide a power that you are not using, and you want to learn how to leverage that power to 
increase your productivity quickly.

Within the first two chapters, you will be able to create basic pivot tables, increase 
your productivity, and produce reports in minutes instead of hours. Within the first seven 
chapters, you will be able to output complex pivot reports with drill-down capabilities 
and accompanying charts. By the end of the book, you will be able to build a dynamic 
pivot table reporting system.

What is new in Excel 2019’s pivot tables

Luckily, Microsoft continues to invest heavily in business intelligence (BI), and pivot tables 
are the front end that let you access the new features. Some of the features added to 
Excel 2019 pivot tables include the following:
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■■ You can specify default settings for all future pivot tables. If you want all pivot 
tables to start in Tabular layout instead of Compact layout, you can specify this. 
Do you prefer Classic layout or do you always replace empty cells with zero? Visit 
File, Options, Data, Pivot Table Defaults to change the settings for all future pivot 
tables.

■■ The automatic date grouping introduced in Excel 2016 pivot tables can now be 
turned off. The setting is found in File, Options, Data. The feature became un-
popular after the release of Excel 2016.

■■ Pivot tables will be doing more summing and less counting. Previously, if you had 
a column with revenue and a few empty cells, the pivot table would choose to 
Count instead of Sum. In Excel 2019, a mix of empty cells and numeric cells will be 
treated like a numeric column and will default to Sum instead of Count.

■■ Power Pivot is now included in all Windows versions of Excel 2019 and Office 365. 
During the tenure of Office 2013–2016, only parts of Power Pivot were available. 
Although some of the Power Pivot functionality was available if you chose Add 
This Data To The Data Model while creating a pivot table, you can now access the 
Power Pivot tab in the ribbon. This allows you to create and view relationships in a 
diagram view. You can choose to sort one column by another column.

■■ With Power Pivot in Excel 2019, your pivot tables benefit from any new functions 
added to the DAX formula language. If you ever wanted to do Median in a pivot 
table or even report Text fields in the Values area, the new DAX functions such as 
MEDIAN and CONCATENATEX allow this to happen.

■■ Power View is being de-emphasized. Microsoft is replacing Power View with Power 
BI Desktop. You will find it difficult to locate the Power View icons in Excel 2019.

■■ If you are using Office 365, you will have access to the Insights command on the 
Insert tab. This command uses artificial intelligence to suggest 30 interesting 
charts or pivot tables that can be created from your data.

Case Study: Life Before Pivot Tables
Say that your manager asks you to create a one-page summary of a sales data-
base. He would like to see total revenue by region and product. Suppose you 
do not know how to use pivot tables. You will have to use dozens of keystrokes 
or mouse clicks to complete this task.

First, you have to build the outline of the report:

1.	 Copy the Product column to a blank section of the worksheet.

2.	 Select Data, Remove Duplicates to eliminate the duplicates.
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3.	 Delete the Product heading.

4.	 Copy the unique list of products and then use Paste Special Transpose to 
turn the list sideways.

5.	 Delete the vertical list of products.

6.	 Copy the Region column to a blank section of the worksheet.

7.	 Select Data, Remove Duplicates to remove the duplicates.

8.	 Delete the Region heading.

9.	 Cut and paste the products so they appear to the left of and below the 
regions.

At this point, with 27 mouse clicks or keystrokes, you’ve built the shell of the 
final report, but there are no numbers inside yet (see Figure I-1).

FIGURE I-1  It took 27 clicks to get to this point.

Next, you need to build the relatively new SUMIFS function to total the rev-
enue for the intersection of a region and product. As shown in Figure I-2, the 
formula =SUMIFS($G$2:$G$564,$C$2:$C$564,L$1,$B$2:$B$564,$K2) does the 
trick. It takes 52 characters plus the Enter key to finish the formula, but I man-
aged to enter the formula in 36 clicks or keystrokes by using some clever navi-
gation tricks I’ve learned over the years.

FIGURE I-2  If this were the year 2006, the SUMIFS function would have been an uglier 
SUMPRODUCT function.

If you are adept at using the Fill handle, you need just two more mouse drags 
to copy the formula to the rest of the table.
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Enter the heading Total for the total row and for the total column. You can do 
this in nine keystrokes if you type the first heading, press Ctrl+Enter to stay in 
the same cell, and then use Copy, select the cell for the second heading, and 
use Paste.

If you select K1:P6 and press Alt+= (that is, Alt and the equal sign key), you can 
add the total formula in three keystrokes.

With this method, which takes 77 clicks or keystrokes, you end up with a nice 
summary report, as shown in Figure I-3. If you could pull this off in 5 or 10 
minutes, you would probably be fairly proud of your Excel prowess; there are 
some good tricks among those 77 operations.

FIGURE I-3  A mere 77 operations later, you have a summary report.

You hand the report to your manager. Within a few minutes, he comes back 
with one of the following requests, which will certainly cause a lot of rework:

■■ Could you put products down the side and regions across the top?

■■ Could you show me the same report for only the manufacturing customers?

■■ Could you show profit instead of revenue?

■■ Could you copy this report for each of the customers?

Invention of the pivot table

When the actual pivot table was invented is in dispute. The Excel team coined the term 
pivot table, which appeared in Excel in 1993. However, the concept was not new. Pito 
Salas and his team at Lotus were working on the pivot table concept in 1986 and released 
Lotus Improv in 1991. Before then, Javelin offered functionality similar to that of pivot 
tables.

The core concept behind a pivot table is that the data, formulas, and data views are 
stored separately. Each column has a name, and you can group and rearrange the data 
by dragging field names to various positions on the report.
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Case Study: Life After Pivot Tables
Say that you’re tired of working so hard to remake reports every time your 
manager wants a change. You’re in luck: You can produce the same report as 
in the last case study but use a pivot table instead. Excel 2019 offers you 10 
thumbnails of recommended pivot tables to get you close to the goal. Follow 
these steps:

1.	 Click the Insert tab of the ribbon.

2.	 Click Recommended PivotTables. The first recommended item is Revenue 
By Region (see Figure I-4).

FIGURE I-4  The first recommended pivot table is as close as you will get to the required 
report.

3.	 Click OK to accept the first pivot table.

4.	 Drag the Product field from the PivotTable Fields list to the Columns area 
(see Figure I-5).
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FIGURE I-5  To finish the report, drag the Product heading to the Columns area.

5.	 Clear Field Headers on the right side of the ribbon.

With just five clicks of the mouse, you have the report shown in Figure I-6.

FIGURE I-6  It took five clicks to create this report.

In addition, when your manager comes back with a request like the ones near 
the end of the prior case study, you can easily use the pivot table to make the 
changes. Here’s a quick overview of the changes you’ll learn to make in the 
chapters that follow:

■■ Could you put products down the side and regions across the top? (This 
change will take you 10 seconds: Drag Product to Rows and Region to Col-
umns.)

■■ Could you show me the same report for only the manufacturing customers? 
(15 seconds: Select Insert Slicer, Sector; click OK; click Manufacturing.)
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■■ Could you show profit instead of revenue? (10 seconds: Clear the check box 
for Revenue, select the check box for Profit.)

■■ Could you copy this report for each of the customers? (30 seconds: Move 
Customer to Report Filter, open the tiny drop-down menu next to the Op-
tions button, choose Show Report Filter Pages, click OK.)

Excel 2019 versus Office 365

The title of this book says Excel 2019. In reality, no one should be buying Office 2019. 
Instead, it is likely that you are renting Office 365. As of May 2018, Office 2019 and Office 
365 were nearly equivalent. 

Here’s why the authors hope that you did not purchase Office 2019: The features 
in Office 2019 will not change. The features in Office 365 will constantly evolve and 
improve. The people who have been using Office 365 have enjoyed the new features 
described earlier in this chapter one to two years before the people who purchased Of-
fice 2019.

Because the title of this book says Excel 2019, the screenshots show the Excel 2019 rib-
bon. However, anyone using Office 365 will have a new look to the ribbon.

Microsoft reduced the number of colors in the Office 365 ribbon. The selected Ribbon 
tab is now underlined instead of being a different color. Compare the Excel 2019 Insert 
tab in Figure I-7 with the Office 365 Insert tab in Figure I-8.

FIGURE I-7  The Excel 2019 ribbon is very similar to the Excel 2016 ribbon.

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


xxx  Introduction

FIGURE I-8  The Office 365 ribbon introduced in the summer of 2018 uses a new font and fewer 
colors.

Microsoft is experimenting with a new ribbon that goes back to a single row like the 
Office 2013 menus. As of the summer of 2018, that new ribbon will debut with Outlook 
and Excel Online and only for Office 365 customers. It remains to be seen if that ribbon 
ever makes it to the desktop version of Excel.

New features in Office 365

After this book is printed, the Excel team will release new features for Excel. Anyone with 
an Office 365 subscription will receive the new features. People with Excel 2019 will not 
get the new features.

For any new features introduced to Office 365, the owners of Excel 2019 will have to 
purchase Office 2022 in order to access those features.

But what is even worse, some features introduced will be marked as Office 365 Exclu-
sive features. Those features will never be available to customers who buy the perpetual 
versions of Office, such as Office 2016, Office 2019, or Office 2022. 

One such feature introduced in early 2018 is the Insights feature. This feature will send 
up to 250,000 cells of your data to a Microsoft server where artificial intelligence looks for 
trends in your data. The first few results from Insights are very similar to the Insert Recom-
mended PivotTable logic introduced in Excel 2013 and shown previously in Figure I-4.

However, if you click the More link, Insights often provides two to three dozen sug-
gestions. Most suggestions will insert a pivot table and a pivot chart. In the first preview 
of Insights, Excel will look for: rank, evenness, trend, composite signal, attribution, out-
standing top two, monotonicity (always increasing or always decreasing), and unimodal-
ity (having a single peak data point).

When I used the data set from this Introduction with Insights in Office 365, Microsoft 
suggested 32 different possible results. One is shown in Figure I-9.
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FIGURE I-9  Excel used artificial intelligence to spot these outliers.

If you regularly purchased every new version of Office, it will cost less to rent Office 
365 at $10 a month than to pay $399 for the perpetual version of Office every 36 months. 
Office 365 offers more features than Excel 2019. Unless your buying pattern is to only 
buy every second or third version of Office, upgrading to Office 365 makes sense.

Who this book is for

This book is a comprehensive-enough reference for hard-core analysts yet relevant to 
casual users of Excel.

We assume that you are comfortable navigating in Excel and that you have some large 
data sets that you need to summarize.

How this book is organized

The bulk of the book covers how to use pivot tables in the Excel user interface. Chapter 
10, “Unlocking features with the Data Model and Power Pivot,” delves into the Power 
Pivot window. Chapter 13, “Using VBA to create pivot tables,” describes how to create 
pivot tables in Excel’s powerful VBA macro language. Anyone who has a firm grasp of 
basics such as preparing data, copying, pasting, and entering simple formulas should not 
have a problem understanding the concepts in this book.
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C H A P T E R  4

Grouping, sorting, and filtering 
pivot data

In this chapter, you will:

•	 Use the PivotTable Fields list

•	 Sort in a pivot table

•	 Filter a pivot table: an overview

•	 Use filters for row and column fields

•	 Filter using the Filters area

•	 Group and create hierarchies in a pivot table

With Excel 2019, Microsoft has reversed the auto date grouping added to Excel 2016. Removing the 
feature was a good move, as the feature proved hard to predict. For anyone who loved the auto 

grouping and the Drill-Down and Drill-Up features, you can re-create them, although it requires a few 
extra steps. Grouping will be covered last in this chapter.

First, a quick overview of the PivotTable Fields. Then, a detailed look at sorting, filtering, and group-
ing a pivot table.

Using the PivotTable Fields list

The entry points for sorting and filtering are spread throughout the Excel interface. It is worth taking a 
closer look at the row header drop-downs and the PivotTable Fields list before diving in to sorting and 
filtering.

As you’ve seen in these pages, I rarely use the Compact form for a pivot table. I use Pivot Table 
Defaults to make sure my pivot tables start in Tabular layout instead of Compact layout. Although there 
are many good reasons for this, one is illustrated in Figures 4-1 and 4-2.
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FIGURE 4-1  The drop-down menu in B3 for Customer is separate from the drop-down menu for Region.

FIGURE 4-2  In Compact form, one single drop-down menu tries to control sorting and filtering for all the row 
fields.

In Figure 4-1, a Region drop-down menu appears in A3. A Customer drop-down menu appears in 
B3. Each of these separate drop-downs offers great settings for sorting and filtering.

When you leave the pivot table in the Compact form, there are not separate headings for Region 
and Customer. Both fields are crammed into column A, with the silly heading Row Labels. This means 
the drop-down menu always offers sorting and filtering options for Region. Every time you go back to 
the A3 drop-down menu with hopes of filtering or sorting the Customer field, you have to reselect Cus-
tomer from a drop-down at the top of the menu. This is an extra click. If you are making five changes 

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


	 Chapter 4  Grouping, sorting, and filtering pivot data	 77

to the Customer field, you are reselecting Customer over and over and over and over and over. This 
should be enough to convince you to abandon the Compact layout.

If you decide to keep the Compact layout and get frustrated with the consolidated Row Labels 
drop-down menu, you can directly access the invisible drop-down menu for the correct field by using 
the PivotTable Fields list, which contains a visible drop-down menu for every field in the areas at the 
bottom. Those visible drop-down menus do not contain the sorting and filtering options.

The good drop-down menus are actually in the top of the Fields list, but you have to hover over the 
field to see the drop-down menu appear. After you hover as shown in Figure 4-3, you can directly ac-
cess the same customer drop-down menu shown in Figure 4-1.

FIGURE 4-3  Hover over the field in the top of the Fields list to directly access the sorting and filtering settings for 
that field.

Docking and undocking the PivotTable Fields list
The PivotTable Fields list starts out docked on the right side of the Excel window. Hover over the green 
PivotTable Fields heading in the pane, and the mouse pointer changes to a four-headed arrow. Drag to 
the left to enable the pane to float anywhere in your Excel window.

After you have undocked the PivotTable Fields list, you might find that it is difficult to redock it on 
either side of the screen. To redock the Fields list, you must grab the title bar and drag until at least 85% 
of the Fields list is off the edge of the window. Pretend that you are trying to remove the floating Fields 
list completely from the screen. Eventually, Excel gets the hint and redocks it. Note that you can dock 
the PivotTable Fields list on either the right side or the left side of the screen.

Rearranging the PivotTable Fields list
As shown in Figure 4-4, a small gear-wheel icon appears near the top of the PivotTable Fields list. Select 
this drop-down menu to see its five possible arrangements. Although the default is to have the Fields 
section at the top of the list and the Areas section at the bottom of the list, four other arrangements are 
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possible. Other options let you control whether the fields in the list appear alphabetically or in the same 
sequence that they appeared in the original data set.

FIGURE 4-4  Use this drop-down menu to rearrange the PivotTable Fields list.

The final three arrangements offered in the drop-down menu are rather confusing. If someone 
changes the PivotTable Fields list to show only the Areas section, you cannot see new fields to add to 
the pivot table.

If you ever encounter a version of the PivotTable Fields list with only the Areas section (see Figure 
4-4) or only the Fields section, remember that you can return to a less-confusing view of the data by 
using the arrangement drop-down menu.

Using the Areas section drop-downs
As shown in Figure 4-5, every field in the Areas section has a visible drop-down arrow. When you select 
this drop-down arrow, you see four categories of choices:

■■ The first four choices enable you to rearrange the field within the list of fields in that area of the 
pivot table. You can accomplish this by dragging the field up or down in the area.

■■ The next four choices enable you to move the field to a new area. You could also accomplish 
this by dragging the field to a new area.

■■ The next choice enables you to remove the field from the pivot table. You can also accomplish 
this by dragging the field outside the Fields list.

■■ The final choice displays the Field Settings dialog box for the field.
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FIGURE 4-5  Use this drop-down menu to rearrange the fields in your pivot table. 

Sorting in a pivot table

Items in the row area and column area of a pivot table are sorted in ascending order by any custom list 
first. This allows weekday and month names to sort into Monday, Tuesday, Wednesday, … instead of the 
alphabetical order Friday, Monday, Saturday, …, Wednesday.

If the items do not appear in a custom list, they will be sorted in ascending order. This is fine, but in 
many situations, you want the customer with the largest revenue to appear at the top of the list. When 
you sort in descending order using a pivot table, you are setting up a rule that controls how that field is 
sorted, even after new fields are added to the pivot table.

Tip  Excel 2019 includes four custom lists by default, but you can add your own custom list 
to control the sort order of future pivot tables. See the section “Using a custom list for sort-
ing,” later in this chapter.

Sorting customers into high-to-low sequence based on revenue
Three pivot tables appear in Figure 4-6. The first pivot table shows the default sort for a pivot table: 
Customers are arranged alphabetically, starting with Adaept, Calleia, and so on.

In the second pivot table, the report is sorted in descending sequence by Total Revenue. This pivot 
table was sorted by selecting cell E3 and choosing the ZA icon in the Data tab of the ribbon. Although 
that sounds like a regular sort, it is better. When you sort inside a pivot table, Excel sets up a rule that 
will be used after you make additional changes to the pivot table.
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FIGURE 4-6  When you override the default sort, Excel remembers the sort as additional fields are added.

The pivot table in columns G:H shows what happens after you add Sector as a new outer row field. 
Within each sector, the pivot table continues to sort the data in descending order by revenue. Within 
Consulting, Surten Excel appears first, with $750K, followed by NetCom, with $614K.

You could remove Customer from the pivot table, do more adjustments, and then add Customer 
back to the column area, and Excel would remember that the customers should be presented from 
high to low.

If you could see the entire pivot table in G3:H35 in Figure 4-6, you would notice that the sectors are 
sorted alphabetically. It might make more sense, though, to put the largest sectors at the top. The fol-
lowing tricks can be used for sorting an outer row field by revenue:

■■ You can select cell G4 and then use Collapse Field on the Analyze tab to hide the customer de-
tail. When you have only the sectors showing, select H4 and click ZA to sort descending. Excel 
understands that you want to set up a sort rule for the Sector field.

■■ You can temporarily remove Customer from the pivot table, sort descending by revenue, and 
then add Customer back.

■■ You can use More Sort Options, as described in the following paragraphs.

To sort the Sector field, you should open the drop-down menu for the Sector field. Hover over Sec-
tor in the top of the PivotTable Fields list, and click the drop-down arrow that appears (see Figure 4-7). 
Or, if your pivot table is shown in Tabular layout or Outline layout, you can simply open the drop-down 
arrow in cell G3.

Inside the drop-down menu, choose More Sort Options to open the Sort (Sector) dialog box. In this 
dialog box, you can choose to sort the Sector field in Descending order by Total $ (see Figure 4-8).
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FIGURE 4-7  For explicit control over sort order, open this drop-down menu.

FIGURE 4-8  Choose to sort Sector based on the Total $ field.

The Sort (Sector) dialog box shown in Figure 4-8 includes a More Options button in the lower left. If 
you click this button, you arrive at the More Sort Options dialog box, in which you can specify a custom 
list to be used for the first key sort order. You can also specify that the sorting should be based on a 
column other than Grand Total.

In Figure 4-10, the pivot table includes Product in the column area. If you wanted to sort the cus-
tomers based on total gadget revenue instead of total revenue, for example, you could do so with the 
More Sort Options dialog box. Here are the steps:

1.	 Open the Customer heading drop-down menu in B4.

2.	 Choose More Sort Options.
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3.	 In the Sort (Customer) dialog box, choose More Options.

4.	 In the More Sort Options (Customer) dialog box, choose the Sort By Values In Selected Column 
option (see Figure 4-9).

5.	 Click in the reference box and then click cell D5. Note that you cannot click the Gadget heading 
in D4; you have to choose one of the Gadget value cells.

6.	 Click OK twice to return to the pivot table.

FIGURE 4-9  Using More Sort Options, you can sort by a specific pivot field item.

If your pivot table has only one field in the Rows area, you can set up the “Sort by Doodads” rule by 
doing a simple sort using the Data tab. Select any cell in B5:B30 and choose Data, ZA. The pivot table 
will be sorted with the largest Doodads customers at the top (see Figure 4-10). Note that you cannot 
sort from the Doodads heading in B4. Sorting from there will sort the product columns by revenue.

FIGURE 4-10  Sort from cell E5 to sort by Doodads.

Using a manual sort sequence
The Sort dialog box offers something called a manual sort. Rather than using the dialog box, you can 
invoke a manual sort in a surprising way.

Note that the products in Figure 4-10 are in the following order: Doodads, Gadget, Gizmo, and 
Widget. It appears that the Doodads product line is a minor product line and probably would not fall 
first in the product list.

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


	 Chapter 4  Grouping, sorting, and filtering pivot data	 83

Place the cell pointer in cell E4 and type the word Doodads. When you press Enter, Excel figures out 
that you want to move the Doodads column to be last. All the values for this product line move from 
column B to column E. The values for the remaining products shift to the left. 

One unintended consequence is that the customers re-sort based on the product that moved to 
column B: Gadget. This is because the “Sort by Doodads” rule was actually a “Sort by whatever is in 
column B” rule.

In Figure 4-11, note the numbers in row 17 and compare them to the numbers in row 5 in Figure 4-10. 
The values followed the change in headings.

This behavior is completely unintuitive. You should never try this behavior with a regular (non–pivot 
table) data set in Excel. You would never expect Excel to change the data sequence just by moving the 
labels. Figure 4-11 shows the pivot table after a new column heading has been typed in cell E4.

FIGURE 4-11  Simply type a heading in E4 to rearrange the columns.

If you prefer to use the mouse, you can drag and drop the column heading to a new location. Select 
a column heading. Hover over the edge of the active cell border until the mouse changes to a four-
headed arrow. Drag the cell to a new location, as shown in Figure 4-12. When you release the mouse, all 
the value settings move to the new column.

FIGURE 4-12  Use drag and drop to move a column to a new position.
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Caution  After you use a manual sort, any new products you add to the data source are 
automatically added to the end of the list rather than appearing alphabetically.

Using a custom list for sorting
Another way to permanently change the order of items along a dimension is to set up a custom list. 
All future pivot tables created on your computer will automatically respect the order of the items in a 
custom list.

The pivot table at the top of Figure 4-13 includes weekday names. The weekday names were added 
to the original data set by using =TEXT(F2,"DDD") and copying down. Excel automatically puts Sunday 
first and Saturday last, even though this is not the alphabetical sequence of these words. This happens 
because Excel ships with four custom lists to control the days of the week, months of the year, and the 
three-letter abbreviations for both.

FIGURE 4-13  The weekday names in B4:H4 follow the order specified in the Custom Lists dialog box.
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You can define your own custom list to control the sort order of pivot tables. Follow these steps to 
set up a custom list:

1.	 In an out-of-the-way section of the worksheet, type the products in their proper sequence. 
Type one product per cell, going down a column.

2.	 Select the cells containing the list of regions in the proper sequence.

3.	 Click the File tab and select Options.

4.	 Select the Advanced category in the left navigation bar. Scroll down to the General group and 
click the Edit Custom Lists button. In the Custom Lists dialog box, your selection address is 
entered in the Import text box, as shown in Figure 4-13.

5.	 Click Import to bring the products in as a new list.

6.	 Click OK to close the Custom Lists dialog box, and then click OK to close the Excel Options 
dialog box.

The custom list is now stored on your computer and is available for all future Excel sessions. All 
future pivot tables will automatically show the product field in the order specified in the custom list. 
Figure 4-14 shows a new pivot table created after the custom list was set up.

FIGURE 4-14  After you define a custom list, all future pivot tables will follow the order in the list.

To sort an existing pivot table by the newly defined custom list, follow these steps:

1.	 Open the Product header drop-down menu and choose More Sort Options.

2.	 In the Sort (Product) dialog box, choose More Options.

3.	 In the More Sort Options (Product) dialog box, clear the AutoSort check box.

4.	 As shown in Figure 4-15, in the More Sort Options (Product) dialog box, open the First Key Sort 
Order drop-down menu and select the custom list with your product names.

5.	 Click OK twice.
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FIGURE 4-15  Choose to sort by the custom list.

Caution  Items in a custom list will automatically sort to the top of all future pivot tables. 
If you have a pivot table of people using their first names, people with names like Jan, May, 
and April will automatically appear before other names. Names that appear in any list, 
even across several custom lists will sort in the wrong sequence. To turn off this behavior 
for one pivot table: right-click one cell in the pivot table and choose PivotTable options. On 
the Totals & Filters tab, unselect Use Custom Lists When Sorting. If you want to turn this off 
for all pivot tables, change the Pivot Table Defaults using File, Options, Data, Edit Default 
Layout, PivotTable Options.

Filtering a pivot table: an overview

Excel 2019 provides dozens of ways to filter a pivot table. Figure 4-16 shows some of the filters available. 
These methods, and the best way to use each one, are discussed in the following sections.
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Column Filter

Report Filter

Timeline Slicer

Row Filter

Value Filter

Top 10 FilterCheck boxes Search Box

FIGURE 4-16  This figure shows a fraction of the available filtering choices.

There are four ways to filter a pivot table, as shown in Figure 4-16:

■■ The Date Timeline filter in G4:H10 was introduced in Excel 2013.

■■ The Market filter in G12:H19 is an example of the slicer introduced in Excel 2010.

■■ A drop-down menu in B1 offers what were known as page filters in Excel 2003, report filters in 
Excel 2010, and now simply filters.

■■ Cell G4 offers the top-secret AutoFilter location.

■■ Drop-down menus in A4 and B3 lead to even more filters.

■■ You see the traditional check box filters for each pivot item.

■■ A Search box filter was introduced in Excel 2010.

■■ A flyout menu has Label filters.

■■ Depending on the field type, you might see a Value Filters flyout menu, including the powerful 
Top 10 filter, which can do Top 10, Bottom 5, Bottom 3%, Top $8 Million, and more.

■■ Depending on the field type, you might see a Date Filters flyout menu, with 37 virtual filters 
such as Next Month, Last Year, and Year to Date.
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Using filters for row and column fields

If you have a field (or fields) in the row or column area of a pivot table, a drop-down menu with filtering 
choices appears on the header cell for that field. In Figure 4-16, a Customer drop-down menu appears 
in A4, and a Product drop-down menu appears in B3. The pivot table in that figure is using Tabular 
layout. If your pivot tables use Compact layout, you see a drop-down menu on the cell with Row Labels 
or Column Labels.

If you have multiple row fields, it is just as easy to sort using the invisible drop-down menus that ap-
pear when you hover over a field in the top of the PivotTable Fields list.

Filtering using the check boxes
You might have a few annoying products appear in a pivot table. In the present example, the Doodads 
product line is a specialty product with very little sales. It might be an old legacy product that is out of 
line, but it still gets an occasional order from the scrap bin. Every company seems to have these orphan 
sales that no one really wants to see.

The check box filter provides an easy way to hide these items. Open the Product drop-down menu 
and clear the Doodads check box. The product is hidden from view (see Figure 4-17) .

FIGURE 4-17  Open the Product filter and clear the Doodads check box.

What if you need to clear hundreds of items’ check boxes in order to leave only a few items se-
lected? You can toggle all items off or on by using the Select All check box at the top of the list. You can 
then select the few items that you want to show in the pivot table.

In Figure 4-18, Select All turned off all customers and then two clicks reselected Excel4Apps and 
F-Keys Ltd.
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FIGURE 4-18  Use Select All to toggle all items off or on.

The check boxes work great in this tiny data set with 26 customers. In real life, with 500 customers in 
the list, it will not be this easy to filter your data set by using the check boxes.

Filtering using the search box
When you have hundreds of customers, the search box can be a great timesaver. In Figure 4-19, the da-
tabase includes consultants, trainers, and other companies. If you want to narrow the list to companies 
with Excel or spreadsheet in their name, you can follow these steps:

1.	 Open the Customer drop-down menu.

2.	 Type Excel in the search box (see Figure 4-19).

FIGURE 4-19  Select the results of the first search.

3.	 By default, Select All Search Results is selected. Click OK.

4.	 Open the Customer drop-down menu again.

5.	 Type spreadsheet in the search box.
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6.	 Choose Add Current Selection to Filter, as shown in Figure 4-20. Click OK.

FIGURE 4-20  For the second search, add these results to the existing filter.

You now have all customers with either Excel or spreadsheet in the name.

Caution  Filters applied with the search box are single-use filters. If you add more data to 
the underlying data and refresh the pivot table, this filter will not be reevaluated.

If you need to reapply the filter, it would be better to use the Label filters as discussed in the 
following section. Label filters would work to find every customer with Excel in the name. It 
would not work to find “Excel or spreadsheet.”

Filtering using the Label Filters option
The search box isn’t perfect. What if you want to find all the Lotus 1-2-3 consultants and turn those 
off? There is no Select Everything Except These Results choice. Nor is there a Toggle All Filter Choices 
choice. However, the Label Filters option enables you to handle queries such as “select all customers 
that do not contain ‘Lotus.’”

Text fields offer a flyout menu called Label Filters. To filter out all of the Insurance customers, you 
can apply a Does Not Contain filter (see Figure 4-21). In the next dialog box, you can specify that you 
want customers that do not contain Excel, Exc, or Exc* (see Figure 4-22).

FIGURE 4-21  Choose Label Filters, Does Not Contain.
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FIGURE 4-22  Specify to exclude customers containing Excel.

Note that label filters are not additive. You can only apply one label filter at a time. If you take the 
data in Figure 4-21 and apply a new label filter of between D and Fzzz, some Excel customers that were 
filtered out in Figure 4-22 come back, as shown in Figure 4-23.

FIGURE 4-23  Note that a second label filter does not get added to the previous filter. Excel is back in.

Filtering a Label column using information in a Values column
The Value Filters flyout menu enables you to filter customers based on information in the Values col-
umns. Perhaps you want to see customers who had between $20,000 and $30,000 of revenue. You can 
use the Customer heading drop-down menu to control this. Here’s how:

1.	 Open the Customer drop-down menu.

2.	 Choose Label Filters.

3.	 Choose Between (see Figure 4-24).

4.	 Type the values 20000 and 30000, as shown in Figure 4-25.

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


92	 Chapter 4  Grouping, sorting, and filtering pivot data

FIGURE 4-24  Value Filters for the Customer column will look at values in the Revenue field. 

FIGURE 4-25  Choose customers between 20000 and 30000, inclusive.

5.	 Click OK.

The results are inclusive; if a customer had exactly $20,000 or exactly $30,000, they are returned 
along with the customers between $20,000 and $30,000.

Note  Choosing a Value filter clears out any previous Label filters.
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Creating a top-five report using the Top 10 filter
One of the more interesting value filters is the Top 10 filter. If you are sending a report to the VP of 
Sales, she is not going to want to see hundreds of pages of customers. One short summary with the top 
customers is almost more than her attention span can handle. Here’s how to create it:

1.	 Go to the Customer drop-down menu and choose Value Filters, Top 10.

2.	 In the Top 10 Filter dialog box, which enables you to choose Top or Bottom, leave the setting at 
the default of Top.

3.	 In the second field, enter any number of customers: 10, 5, 7, 12, or something else.

4.	 In the third drop-down menu on the dialog box, select from Items, Percent, and Sum. You could 
ask for the top 10 items. You could ask for the top 80% of revenue (which the theory says should 
be 20% of the customers). Or you could ask for enough customers to reach a sum of $5 million 
(see Figure 4-26).

FIGURE 4-26  Create a report of the top five customers.

The $1,758,220 total shown in cell B9 in Figure 4-26 is the revenue of only the visible customers. It 
does not include the revenue for the remaining customers. You might want to show the grand total of 
all customers at the bottom of the list. You have a few options:

■■ A setting on the Design tab, under the Subtotals drop-down menu, enables you to include 
values from filtered items in the totals. This option is available only for OLAP data sets and data 
sets where you choose Add This Data To The Data Model when creating the pivot table.

Note  See Chapter 10, “Unlocking features with the Data Model and Power Pivot,” for more 
information on working with Power Pivot.
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■■ You can remove the grand total from the pivot table in Figure 4-27 and build another one-row 
pivot table just below this data set. Hide the heading row from the second pivot table, and you 
will appear to have the true grand total at the bottom of the pivot table.

■■ If you select the blank cell to the right of the last heading (C3 in Figure 4-26), you can turn on 
the filter on the Data tab. This filter is not designed for pivot tables and is usually grayed out. 
After you’ve added the regular filters, open the drop-down menu in B3. Choose Top 10 Filter 
and ask for the top six items, as shown in Figure 4-27. This returns the top five customers and 
the grand total from the data set.

Caution  Be aware that this method is taking advantage of a bug in Excel. Normally, the 
Filter found on the Data tab is not allowed in a pivot table. If you use this method and later 
refresh the pivot table, the Excel team will not update the filter for you. As far as they know, 
the option to filter is grayed out when you are in a pivot table.

FIGURE 4-27  You are taking advantage of a hole in the fabric of Excel to apply a regular AutoFilter to a pivot table.

Filtering using the Date filters in the Label drop-down menu
If your label field contains all dates, Excel replaces the Label Filter flyout with a Date Filters flyout. These 
filters offer many virtual filters, such as Next Week, This Month, Last Quarter, and so on (see Figure 
4-28).

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


	 Chapter 4  Grouping, sorting, and filtering pivot data	 95

FIGURE 4-28  The Date Filters menu offers various virtual date periods.

If you choose Equals, Before, After, or Between, you can specify a date or a range of dates.

Options for the current, past, or next day, week, month, quarter, or year occupy 15 options. Com-
bined with Year To Date, these options change day after day. You can pivot a list of projects by due date 
and always see the projects that are due in the next week by using this option. When you open the 
workbook on another day, the report recalculates.

Tip  A week runs from Sunday through Saturday. If you select Next Week, the report always 
shows a period from the next Sunday through the following Saturday.

When you select All Dates In The Period, a new flyout menu offers options such as Each Month and 
Each Quarter.
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Caution  If your date field contains dates and times, the Date Filters might not work as 
expected. You might ask for dates equal to 4/15/2022, and Excel will say that no records are 
found. The problem is that 6:00 p.m. on 4/15/2022 is stored internally as 44666.75, with the 
“.75” representing the 18 hours elapsed in the day between midnight and 6:00 p.m. If you 
want to return all records that happened at any point on April 15, select the Whole Days 
check box in the Date Filter dialog box.

Filtering using the Filters area

Pivot table veterans remember the old Page area section of a pivot table. This area has been renamed 
the Filters area and still operates basically the same as in legacy versions of Excel. Microsoft did add the 
capability to select multiple items from the Filters area. Although the Filters area is not as showy as slic-
ers, it is still useful when you need to replicate your pivot table for every customer.

Adding fields to the Filters area
The pivot table in Figure 4-29 is a perfect ad-hoc reporting tool to give to a high-level executive. He 
can use the drop-down menus in B1:B4 and E1:E4 to find revenue quickly for any combination of sector, 
region, market, rep, customer, product, date, or weekday. This is a typical use of filters.

FIGURE 4-29  With multiple fields in the Filters area, this pivot table can answer many ad-hoc queries.

To set up the report, drag Revenue and Cost to the Values area and then drag as many fields as 
desired to the Filters area.

If you add many fields to the Filters area, you might want to use one of the obscure pivot table op-
tions settings. Click Options on the Analyze tab. On the Layout & Format tab of the PivotTable Options 
dialog box, change Report Filter Fields per Column from 0 to a positive number. Excel rearranges the 
Filter fields into multiple columns. Figure 4-29 shows the filters with four fields per column. You can 
also change Down, Then Over to Over, Then Down to rearrange the sequence of the Filter fields.

Choosing one item from a filter
To filter the pivot table, click any drop-down menu in the Filters area of the pivot table. The drop-down 
menu always starts with (All) but then lists the complete unique set of items available in that field.
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Choosing multiple items from a filter
At the bottom of the Filters drop-down menu is a check box labeled Select Multiple Items. If you select 
it, Excel adds a check box next to each item in the drop-down menu. This enables you to select multiple 
items from the list.

In Figure 4-30, the pivot table is filtered to show revenue from multiple sectors, but it is impossible 
to tell which sectors are included.

FIGURE 4-30  You can select multiple items, but after the Filter drop-down menu closes, you cannot tell which 
items were selected.

Tip  Selecting multiple items from the filter leads to a situation where the person reading 
the report will not know which items are included. Slicers solve this problem.

Replicating a pivot table report for each item in a filter
Although slicers are now the darlings of the pivot table report, the good old-fashioned report filter can 
still do one trick that slicers cannot do. Say you have created a report that you would like to share with 
the industry managers. You have a report showing customers with revenue and profit. You would like 
each industry manager to see only the customers in their area of responsibility.

Follow these steps to quickly replicate the pivot table:

1.	 Make sure the formatting in the pivot table looks good before you start. You are about to make 
several copies of the pivot table, and you don’t want to format each worksheet in the work-
book, so double-check the number formatting and headings now.

2.	 Add the Sector field to the Filters area. Leave the Sector filter set to (All).

3.	 Select one cell in the pivot table so that you can see the Analyze tab in the ribbon.

4.	 Find the Options button in the left side of the Analyze tab. Next to the Options tab is a drop-
down menu. Don’t click the big Options button. Instead, open the drop-down menu (see Figure 
4-31).
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FIGURE 4-31  Click the tiny drop-down arrow next to the Options button.

5.	 Choose Show Report Filter Pages. In the Show Report Filter Pages dialog box, you see a list of 
all the fields in the report area. Because this pivot table has only the Sector field, this is the only 
choice (see Figure 4-32).

FIGURE 4-32  Select the field by which to replicate the report.

6.	 Click OK and stand back.

Excel inserts a new worksheet for every item in the Sector field. On the first new worksheet, Excel 
chooses the first sector as the filter value for that sheet. Excel renames the worksheet to match the 
sector. Figure 4-33 shows the new Consulting worksheet, with neighboring tabs that contain Museums, 
Retail, Training, and Utilities.

Tip  If the underlying data changes, you can refresh all of the Sector worksheets by using 
Refresh on one Sector pivot table. After you refresh the Consulting worksheet, all the pivot 
tables refresh.
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FIGURE 4-33  Excel quickly adds one page per sector.

Filtering using slicers and timelines
Slicers are graphical versions of the Report Filter fields. Rather than hiding the items selected in the 
filter drop-down menu behind a heading such as (Multiple Items), the slicer provides a large array of 
buttons that show at a glance which items are included or excluded.

To add slicers, click the Insert Slicer icon on the Analyze tab. Excel displays the Insert Slicers dialog 
box. Choose all the fields for which you want to create graphical filters, as shown in Figure 4-34.

FIGURE 4-34  Choose fields for slicers.
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Initially, Excel chooses one-column slicers of similar color in a cascade arrangement (see Figure 
4-35). However, you can change these settings by selecting a slicer and using the Slicer Tools Options 
tab in the ribbon.

FIGURE 4-35  The slicers appear with one column each.

You can add more columns to a slicer. If you have to show 50 two-letter state abbreviations, that 
will look much better as 5 rows of 10 columns than as 50 rows of 1 column. Click the slicer to get access 
to the Slicer Tools Analyze tab. Use the Columns spin button to increase the number of columns in 
the slicer. Use the resize handles in the slicer to make the slicer wider or shorter. To add visual interest, 
choose a different color from the Slicer Styles gallery for each field.

After formatting the slicers, arrange them in a blank section of the worksheet, as shown in Figure 4-36.

FIGURE 4-36  After formatting, your slicers might fit on a single screen.
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Three colors might appear in a slicer. The dark color indicates items that are selected. Gray boxes 
often mean the item has no records because of other slicers. White boxes indicate items that are not 
selected.

Note that you can control the heading for the slicer and the order of items in the slicer by using the 
Slicer Settings icon on the Slicer Tools Options tab of the ribbon. Just as you can define a new pivot 
table style, you can also right-click an existing slicer style and choose Duplicate. You can change the 
font, colors, and so on.

A new icon debuted in Excel 2016, in the top bar of the slicer. The icon appears as three check marks. 
When you select this icon, you can select multiple items from the slicer without having to hold down 
the Ctrl key.

Using timelines to filter by date
After slicers were introduced in Excel 2010, there was some feedback that using slicers was not an ideal 
way to deal with date fields. You might end up adding some fields to your original data set to show 
(perhaps) a decade and then use the group feature for year, quarter, and month. You would end up 
with a whole bunch of slicers all trying to select a time period, as shown in Figure 4-37.

FIGURE 4-37  Four different slicers are necessary to filter by date.

For Excel 2013, Microsoft introduced a new kind of filter called a Timeline slicer. To use one, select 
one cell in your pivot table and choose Insert Timeline from the Analyze tab. Timeline slicers can only 
apply to fields that contain dates. Excel gives you a list of date fields to choose from, although in most 
cases, there is only one date field from which to choose.

Figure 4-38 shows a Timeline slicer. Perhaps the best part of a Timeline slicer is the drop-down 
menu that lets you repurpose the timeline for days, months, quarters, or years. This works even if you 
have not grouped your daily dates up to months, quarters, or years.
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FIGURE 4-38  A single Timeline slicer can filter your pivot table by month, quarter, year, or day.

Driving multiple pivot tables from one set of slicers
Chapter 12, “Enhancing pivot table reports with macros,” includes a tiny macro that lets you drive two 
pivot tables with one set of filters. This has historically been difficult to do unless you used a macro.

Now, one set of slicers or timelines can be used to drive multiple pivot tables or pivot charts. In Fig-
ure 4-39, the Market slicer is driving three elements. It drives the pivot table in the top left with revenue 
by sector and product. It drives two pivot tables created for the top-right and lower-left charts.

FIGURE 4-39  Three pivot elements controlled by the same slicer.
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Note  For more information about how to create pivot charts, refer to Chapter 6, “Using 
pivot charts and other visualizations.”

The following steps show you how to create three pivot tables that are tied to a single slicer:

1.	 Create your first pivot table.

2.	 Select a cell in the first pivot table. Choose Insert Slicer. Choose one or more fields to be used as 
a slicer. Alternatively, insert a Timeline slicer for a date field.

3.	 Select the entire pivot table.

4.	 Copy with Ctrl+C or the Copy command.

5.	 Select a new blank area of the worksheet.

6.	 Paste. Excel creates a second pivot table that shares the pivot cache with the first pivot table. In 
order for one slicer to run multiple pivot tables, they must share the same pivot cache.

7.	 Change the fields in the second pivot table to show some other interesting analysis.

8.	 Repeat steps 3–7 to create a third copy of the pivot table.

The preceding steps require you to create the slicer after you create the first pivot table but before 
you make copies of the pivot table. 

If you already have several existing pivot tables and need to hook them up to the same slicer, follow 
these steps:

1.	 Click the slicer to select it. When the slicer is selected, the Slicer Tools Design tab of the ribbon 
appears.

2.	 Select the Slicer Tools Design tab and choose Report Connections. Excel displays the Report 
Connections (Market) dialog box. Initially, only the first pivot table is selected.

3.	 As shown in Figure 4-40, choose the other pivot tables in the dialog box and click OK.

FIGURE 4-40  Choose to hook this slicer up to the other pivot tables.

4.	 If you created multiple slicers and/or timelines, repeat steps 1 through 3 for the other slicers.

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


104	 Chapter 4  Grouping, sorting, and filtering pivot data

The result is a dashboard in which all of the pivot tables and pivot charts update in response to 
selections made in the slicer (see Figure 4-41).

FIGURE 4-41  All of the pivot charts and pivot tables update when you choose from the slicer.

Tip  The worksheet in Figure 4-41 would be a perfect worksheet to publish to SharePoint 
or to your OneDrive. You can share the workbook with coworkers and allow them to interact 
with the slicers. They won’t need to worry about the underlying data or enter any numbers; 
they can just click on the slicer to see the reports update.

Grouping and creating hierarchies in a pivot table

Pivot tables have the ability to do roll-ups in memory. You can roll daily dates up to weeks, months, 
quarters, or years. Time can roll up to minutes or hours. Numbers can be grouped into equal-size buck-
ets. Text entries can be grouped into territories. 

You can use the Power Pivot grid to define a hierarchy so you can quickly drill down on a pivot table or 
chart.

Grouping numeric fields
The Grouping dialog box for numeric fields enables you to group items into equal ranges. This can be 
useful for creating frequency distributions. The pivot table in Figure 4-42 is quite the opposite of any-
thing you’ve seen so far in this book. The numeric field—Revenue—is in the Rows area. A text field—
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Customer—is in the Values area. When you put a text field in the Values area, you get a count of how 
many records match the criteria. In its present state, this pivot table is not that fascinating; it is telling 
you that exactly one record in the database has a total revenue of $23,990.

FIGURE 4-42  Nothing interesting here—just lots of order totals that appear exactly one time in the database.

Select one number in column A of the pivot table. Select Group Field from the Analyze tab of the 
ribbon. Because this field is not a date field, the Grouping dialog box offers fields for Starting At, End-
ing At, and By. As shown in Figure 4-43, you can choose to show amounts from 0 to 30,000 in groups of 
5,000.

FIGURE 4-43  Create a frequency distribution by grouping the order size into $5,000 buckets.

After grouping the order size into buckets, you might want to add additional fields, such as Revenue 
and % Of Revenue shown as a percentage of the total.

Note  The grouping dialog box requires all groups to be the same size. I have heard ques-
tions where people want to group into 0–100K, 200K–500K, but this is not possible using the 
Grouping feature. You would have to add a new column to the source data in order to create 
these groupings.
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Case Study: Grouping text fields for redistricting
Say that you get a call from the VP of Sales. The Sales Department is secretly considering 
a massive reorganization of the sales regions. The VP would like to see a report showing 
revenue after redistricting. You have been around long enough to know that the proposed 
regions will change several times before the reorganization happens, so you are not willing 
to change the Region field in your source data quite yet.

First, build a report showing revenue by market. The VP of Sales is proposing eliminating 
two regional managers and redistricting the country into three super-regions. While hold-
ing down the Ctrl key, highlight the five regions that will make up the new West region. 
Figure 4-44 shows the pivot table before the first group is created.

FIGURE 4-44  Use the Ctrl key to select the noncontiguous cells that make up the new region.

From the Analyze tab, click Group Selection. Excel adds a new field called Market2. The five 
selected regions are arbitrarily rolled up to a new territory called Group1. In Figure 4.45, the 
Group1 label in A4 is the first item in the new Market2 virtual field. The other items in the 
Market2 field includee Atlanta in A10, Charlotte in A12 and so on. The similar items in A11 and 
A13 are items in the original Market field. Use care while holding down the Ctrl key to select 
the unbolded markets for the South region: Atlanta in row 11, Charlotte in row 13, Huntsville 
in row 11, and Louisville in row 23...

Click Group Selection to group the markets in the proposed Southeast region. Repeat to 
group the remaining regions into the proposed Northeast region. Figure 4-46 shows what 
it looks like when you have grouped the markets into new regions. Five things need further 
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adjustment: the names of Group1, Group2, Group3, and Market2, and the lack of subtotals 
for the outer row field.

FIGURE 4-45  The first super-region is arbitrarily called Group1.

FIGURE 4-46  The markets are grouped, but you have to do some cleanup.

Cleaning up the report takes only a few moments:

1.	 	Select cell A4. Type West to replace the arbitrary name Group1.

2.	 Select cell A10. Type Southeast to replace the arbitrary name Group2.
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3.	 Select A15. Type Northeast to replace Group3.

4.	 Select any outer heading in A4, A10, or A15. Click Field Settings on the Analyze tab.

5.	 In the Field Settings dialog box, replace the Custom Name of Market2 with Proposed 
Region. Also, in the Field Settings dialog box, change the Subtotals setting from None 
to Automatic.

Figure 4-47 shows the pivot table that results, which is ready for the VP of Sales.

FIGURE 4-47  It is now easy to see that these regions are heavily unbalanced.

You can probably predict that the Sales Department needs to shuffle markets to balance the 
regions. To go back to the original regions, select any Proposed Region cell in A4, A10, or 
A15 and choose Ungroup. You can then start over, grouping regions in new combinations.

Grouping date fields manually
Excel provides a straightforward way to group date fields. Select any date cell in your pivot table. On 
the Analyze tab, click Group Field in the Group option.

When your field contains date information, the date version of the Grouping dialog box appears. By 
default, the Months option is selected. You have choices to group by Seconds, Minutes, Hours, Days, 
Months, Quarters, and Years. It is possible—and usually advisable—to select more than one field in the 
Grouping dialog box. In this case, select Months and Years, as shown in Figure 4-48.

There are several interesting points to note about the resulting pivot table. First, notice that the 
Years field has been added to the PivotTable Fields list. Don’t let this fool you. Your source data is not 
changed to include the new field. Instead, this field is now part of your pivot cache in memory.
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FIGURE 4-48  Business users of Excel usually group by months (or quarters) and years.

Another interesting point is that, by default, the Years field is automatically added to the same area 
as the original date field in the pivot table layout, as shown in Figure 4-49. Although this happens au-
tomatically, you are free to pivot months and years onto the opposite axis of the report. This is a quick 
way to create a year-over-year sales report.

FIGURE 4-49  By default, Excel adds the new grouped date field to your pivot table layout. 
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Including years when grouping by months
Although this point is not immediately obvious, it is important to understand that if you group a date 
field by month, you also need to include the year in the grouping. If your data set includes January 
2024 and January 2025, selecting only months in the Grouping dialog box will result in both January 
2024 and January 2025 being combined into a single row called January (see Figure 4-50).

FIGURE 4-50  If you fail to include the Year field in the grouping, the report mixes sales from last January and this 
January into a single row called January.

Grouping date fields by week
The Grouping dialog box offers choices to group by second, minute, hour, day, month, quarter, and 
year. It is also possible to group on a weekly or biweekly basis.

The first step is to find either a paper calendar or an electronic calendar, such as the Calendar fea-
ture in Outlook, for the year in question. If your data starts on January 1, 2024, it is helpful to know that 
January 1 is a Monday that year. You need to decide if weeks should start on Sunday or Monday or any 
other day. For example, you can check the paper or electronic calendar to learn that the nearest start-
ing Sunday is December 31, 2023.

Select any date heading in your pivot table. Then select Group Field from the Analyze tab. In the 
Grouping dialog box, clear all the By options and select only the Days field. This enables the spin but-
ton for Number of Days. To produce a report by week, increase the number of days from 1 to 7.

Next, you need to set up the Starting At date. If you were to accept the default of starting at Janu-
ary 1, 2024, all your weekly periods would run from Monday through Sunday. By checking a calendar 
before you begin, you know that you want the first group to start on December 31, 2023, to have weeks 
that run Sunday through Monday. Figure 4-51 shows the settings in the Grouping dialog box and the 
resulting report.
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Choose only Days

Start date

Number of days

FIGURE 4-51  Group dates up to weekly periods.

Caution  If you choose to group by week, none of the other grouping options can be se-
lected. You cannot group this or any field by month, quarter, or year. You cannot add calcu-
lated items to the pivot table.

AutoGrouping pivot table dates
Excel 2016 introduced an AutoGroup feature for dates. If you dragged a date field to a pivot table, Excel 
would quickly add date rollups and define a hierarchy for the dates.

The feature was turned on by default, and the only way to turn it off was a change in the Registry. 

I love the concept of teaching people that daily dates can easily be rolled up. But for the people who 
needed to report daily dates, the AutoGroup was inconsistent and confusing. The logic used to choose 
which rollups would be present would sometimes leave out daily dates from the hierarchy.

Today, Excel 2019 will not automatically AutoGroup. You can choose to allow the AutoGroup if you 
loved this feature. Go To File, Options, Data, and deselect Disable Automatic Grouping Of Date/Time 
Columns In Pivot Tables.

Understanding how Excel decides what to AutoGroup
If you have daily dates that include an entire year or that fall in two or more years, Excel 2019 groups 
the daily dates to include years, quarters, and months. If you need to report by daily dates, you will 
have to select any date cell, choose Group Field, and add Days. Note that the rules change if your data 
is in the Data Model. In that case, AutoGroup would include daily dates as well.

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


112	 Chapter 4  Grouping, sorting, and filtering pivot data

If you have daily dates that fall within one calendar year and span more than one month, Excel 
groups the daily dates to month and includes daily dates.

Caution  If your company is closed on New Year’s Day and you have no sales on January 1, 
a data set that stretches from January 2 to December 31 will fit the “less than a full year” case 
and will include months and daily dates.

If your data contains times that do not cross over midnight, you get hours, minutes, and seconds. If 
the times span more than one day, you get days, hours, minutes, and seconds.

Using AutoGroup
Say that you have a column in your data set with daily dates that span two years. When you add this 
Date field to the Rows area of your pivot table, you will see rows for each year instead of hundreds of 
daily dates. If your pivot table is in Tabular layout, you will see extra columns for Quarter and Date that 
appear to have no data (see Figure 4-52).

When you look in the Pivot Table Fields list, you see that the Rows area automatically includes three 
fields: Years, Quarter, and Date. All three of these are virtual fields created by grouping the daily dates 
up to months, quarters, and years.

The three fields are added to either the Rows area or the Columns area. However, only the highest 
level of the date field will be showing. To see the quarters and years, click one cell that contains a year 
and then click the Expand button in the Analyze tab of the ribbon (see Figure 4-53). To see months, 
select a cell containing a quarter and click the Expand button again (see Figure 4-54).

FIGURE 4-52  Excel can automatically groups two years’ worth of daily dates up to months, quarters, and years
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FIGURE 4-53  Use Expand Field to show the quarters.

FIGURE 4-54  Expand Field again to show the monthly data.

Creating an easy year-over-year report
You can use date grouping to easily create a year-over-year report. You can either manually group the 
dates to years or use the AutoGroup.

Follow these steps:

1.	 Create a pivot table with Years in the Columns area and Months in the Rows area. Drag Revenue 
to the Values area. By default, the pivot table will offer a Grand Total column, as shown in Figure 
4-55.

2.	 Right-click the Grand Total heading and choose Remove Grand Total.

3.	 Drag Revenue a second time to the Values area.

4.	 In the Columns area, drag Years so it is below Values. You will have the pivot table shown in 
Figure 4-56.
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FIGURE 4-55  Group daily dates to months and years. Drag Years to go across the report.

FIGURE 4-56  This year and last year appear twice across the top of the report.

5.	 Double-click the Sum of Revenue2 heading in cell D4 to display the Value Field Settings dialog 
box.

6.	 In the Value Field Settings dialog box, select the Show Values As tab. In the Show Values As 
drop-down menu, choose % Difference From. In the Base Field list, choose Years. In the Base 
Item, choose (Previous), as shown in Figure 4-57.
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FIGURE 4-57  Change the second Revenue columns to percentage difference from the previous year.

7.	 Close the Value Field Settings dialog box. Column E will show the percentage change from the 
first year to the last year. Column D will be blank because the pivot table has no data from 2023 
to use to compare to 2024.

8.	 Hide column D.

9.	 Select the 2025 heading in E5. Press Ctrl+1 for Format Cells. On the Number tab, choose Cus-
tom. Type a format of ;;;"% Change".

You have a report showing year 1 versus year 2 and a percentage change. You can easily remove the 
Months from column A and insert Region, Market, or Product to see the year-over-year change. Figure 
4-58 shows a year-over-year report for Regions.

FIGURE 4-58  Once you have the year-over-year report set up, you can swap any field in to column A.
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Creating hierarchies

Back in Figures 4-53 through 4-55, you used the Expand Field to drill in to different date levels. If you 
build your pivot table using the Data Model, you can use the Diagram View in Power Pivot to create a 
formal hierarchy. Once you have a hierarchy in your pivot table, you can use the Drill Down and Drill Up 
buttons that are perpetually grayed out in the ribbon.

Consider the pivot table and pivot chart shown in Figure 4-59. The pivot table is built using the Data 
Model; when you choose Insert Pivot Table, make sure to choose Add This Data To The Data Model. The 
pivot table has regions in the Rows area and Products in the Columns area. The pivot chart is showing a 
stacked column chart.

FIGURE 4-59  A pivot table and a pivot chart without any hierarchy.

Follow these steps to add a hierarchy below Region:

1.	 Click the Manage icon in the Power Pivot tab of the ribbon.

2.	 On the Home tab of the Power Pivot for Excel window, click Diagram View.

3.	 Resize the Range table so you can see all the fields.

4.	 Click on the top field for the hierarchy: Region. Ctrl+click the remaining members of the hierar-
chy: Market and Rep.

5.	 Right-click on Region and choose Create Hierarchy (see Figure 4-60).
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FIGURE 4-60  Select Region, Market, and Rep. Right-click and choose Create Hierarchy.

6.	 Hierarchy1 will appear at the bottom of the table. Right-click the name and choose Rename. 
Type a meaningful name such as Geography (see Figure 4-61).

FIGURE 4-61  The hierarchy is shown at the bottom of the table.

7.	 Carefully review the sequence of the hierarchy. In Figure 4-61, Rep is appearing before Market. 
This is incorrect. Right-click on Market and choose Move Up.

8.	 Close the Power Pivot window and return to Excel. After a brief pause, the PivotTable Fields list 
will show the table name (Range), the hierarchy name (Geography), and something called More 
Fields.
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9.	 Remove Region from the Rows area. Choose the Geography hierarchy from the PivotTable 
Fields list. As shown in Figure 4-62, you have something very similar to Figure 4-59. However, 
note that Drill Down is now enabled in the ribbon.

FIGURE 4-62  Plus signs appear next to each region. The Drill Down icon is enabled.

10.	 Select cell A7 for South. Click on Drill Down. The pivot table and pivot chart will change to show 
the markets in the South region (see Figure 4-63).

You can keep using Drill Down or Drill Up to travel through the hierarchy.
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FIGURE 4-63  After drilling down on the South region, the markets in the South appear. The Drill Up icon is now 
enabled.

Next steps

In Chapter 5, “Performing calculations in pivot tables,” you’ll learn how to use pivot table formulas to 
add new virtual fields to a pivot table.
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% Difference From option (Value Field Settings 

dialog box, Show Values As tab), 68-69
% Of option (Value Field Settings dialog box, Show 

Values As tab), 66
% Of Parent Column option (Value Field Settings 

dialog box, Show Values As tab), 69
% Of Parent Row option (Value Field Settings 

dialog box, Show Values As tab), 69
% Of Parent Total option (Value Field Settings 
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Show Values As tab), 66

Numbers
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aerial photography maps, 295
animating data over time, 297-298
annotation (text boxes), 294, 299
bubble charts, 294
column charts, 292, 296

combining data sets, 297
custom maps, 290
custom shapes, 290
data cards (tooltips), 296
filters, 296
flat maps, 295-296
geocoding data, 290-291
heat maps, 294
hiding

legends, 296
panes, 296
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maps, 295

latitude, 290
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navigating maps, 292-293
pie charts, 294
preparing data for, 289
region maps, 294
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3D Map

relationships (table), 290
resizing legends, 296
store maps, using instead of globes (case 

study), 299-302
table relationships, 290
timelines, 298
tours, creating, 298-299
vantage point, moving, 293
video, creating, 299
zooming in/out of maps, 293

32-bit Excel
Data Model and, 287
Power Pivot and, 287

A
Access (MS), creating pivot tables, 181-184
ActiveX controls versus form controls, 307
adding

calculated columns in Power Pivot grid, 
281-282

calculations to OLAP pivot tables, 250
columns

calculated columns in Power Pivot grid, 
281-282

to slicers, 100
with Power Query, 275-276

fields
model fields to pivot tables, 383
numeric fields to Values area, 384
rank number fields to pivot tables, 

396-398
to data areas, 332-333
to reports, 22-24

functionality to recorded macros, 308-309
layers to reports, 25

linked tables to Data Model, 279
model fields to pivot tables, 383
numeric fields to Values area, 384
rank number fields to pivot tables, 396-398
scrollbars to spreadsheets, 309-312
tables to Data Model, 180, 279, 381

add-ins (Power Query), 188
Advanced Query Editor (Power Query), 195
aerial photography maps in 3D Map, 295
Allington, Matt, 287
analyzing OLAP pivot table data (what-if analysis), 

258-259
animation in 3D Map, 297-298
annotation (text boxes) in 3D Map, 294, 299
applied steps (Power Query), 194-195, 276
Areas section drop-downs (Field list), 78-79
arrow keys in formula creation, 286
artificial intelligence. See Insights feature
AutoComplete tool (VBA), 326
auto date-grouping, 75
AutoFiltering pivot tables, 401-404
AutoFit, column widths, 59
AutoGroup, 330

date groups, 344
determining AutoGroup criteria, 111
using, 112
year-over-year reports, creating, 113-115

AutoShow (VBA), executive overviews of pivot 
tables, 365-367

AutoSort, pivot table sort order, 347

B
backward compatibility

Check Compatibility tool, 7-9
pivot tables and Excel, 7-8
Timeline slicer, 35
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calculations

basic pivot table creation, 19
adding

fields to reports, 22
layers to reports, 25

choosing report location, 20
classic pivot table layout, 26-27
data selection, 20
fields

adding to reports, 24
dragging/dropping in reports, 25-26

filters, creating, 27
Ideas feature, 29-30
laying out reports, 22-24

deferring layout updates, 39-40
starting over, 40

PivotTable Fields list, 21-22
adding fields to tables, 24
dragging/dropping fields in tables, 

25-26
rearranging tables, 25-26
Recommended PivotTables, 28-30
slicers

connecting to multiple pivot tables, 
32-33

standard slicers, 31-33
Timeline slicer, 34-35

big data files, processing with Power Query, 
273-275

blank cells
deleting from pivot tables, 346-347
filling

in data area, 336
in row area, 336

in data sources, 14
in numeric columns, 24
replacing with zeros, 47-48

blank rows (layouts), 50, 56-57
bubble charts in 3D Map, 294

C
calculated columns, adding in Power Pivot grid, 

281-282
calculated fields, 286

calculated data fields, 358-359
creating, 123-128
DAX measures, using instead of calculated 

fields (case study), 141-145
defined, 121
inserting into pivot tables, 124-125
manually adding to data sources, 122-123
rules specific to, 139-140
summarizing next year’s forecast (case study), 

129-133
calculated items, 286

changing solve order of, 147
creating, 133-137
defined, 121
rules for, 145-146

calculated measures (OLAP), 250-253
calculated members (OLAP), 250, 254-257
calculations, 355, 384. See also measures

adding to OLAP pivot tables, 250
calculated fields, 286

calculated data fields, 358-359
creating, 123-128
creating with formulas outside a pivot 

table, 123, 124
defined, 121
inserting into pivot tables, 124-125
manually adding to data sources, 

122-123
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rules specific to, 139-140
summarizing next year’s forecast (case 

study), 129-133
using DAX measures instead of cal-

culated fields (case study), 141-145
calculated items, 359-361

changing solve order of, 147
creating, 133-137
defined, 121
rules for, 145-146

calculating groups, 361-362
calculation functions, 356-358
cell references and, 139
constants and, 139
DAX measures, 139

defined, 121
using DAX measures instead of cal-

culated fields (case study), 141-145
deleting, 146-147
documenting, 148
editing, 146-147
grand total references, 139
managing, 257-258
multiple data fields, troubleshooting issues 

with, 355-356
named ranges and, 139
OLAP pivot tables, managing calculations, 

257-258
operator precedence, 138
Show Values As tab (Value Field Settings 

dialog box), performing calculations 
with, 362-363

subtotal references, 139
totals, referencing, 139
VBA calculation options per Excel version, 364
worksheet functions and, 139

case studies
calculated fields, using DAX measures instead 

of, 141-145
converting live pivot tables to static values, 

54-55
data sources, cleaning up, 15-19
grouping text fields for redistricting, 106-108
interactive reports showing revenue by 

product and time period (case study), 
creating, 157-161

life after pivot tables, xxvii-xxviii, xxix
life before pivot tables, xxiv-xxvi
market activity analysis, 35-36
store maps, using instead of globes, 299-302
summarizing next year’s forecast, 129-133
transposing data sets with Power Query, 

202-204
categorizing columns with Power Pivot, 287
cells

blank cells
deleting from pivot tables, 346-347
filling in data area, 336
filling in row area, 336
in data sources, 14
in numeric columns, 24
replacing with zeros, 47-48

calculations and cell references, 139
deleting cells, preventing errors, 336-337
empty cells, filling in row fields, 393-396
extracting from pivot tables based on pivot 

caches, 232
formatting in Office 365, 72
inserting cells, preventing errors, 336-337

changing
default pivot table behaviors for future pivot 

tables, 392
field names, 49
pivot table names, 33
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columns

previewing changes with Live Preview feature, 
60

solve order of calculated items, 147
charts

bubble charts in 3D Map, 294
column charts in 3D Map, 292
column charts in 3D Map, 296
cross-filtering charts with Power BI Desktop, 

218
pie charts in 3D Map, 294
pivot charts

alternatives to, 161-165
creating, 150-153
defined, 149
formatting limitations, 156
interactive reports showing revenue 

by product and time period (case 
study), 157-161

pivot field buttons, 152-153, 160
pivot tables and, 154-156, 162
x-axis, 155
XY scatter charts, 164-165
y-axis, 155

check boxes, filtering with, 88-89
Check Compatibility tool, 7-9
classic pivot table layout, 26-27
cleaning up data sources (case study), 15-19
clearing pivot table layouts, 40
Code window (Visual Basic Editor), 326
coding (object-oriented)

data ranges, 327-328
End+Down arrow versus End+Up arrow, 328
shortening code, 329
super-variables, 328-329
With and End With, 329

Collie, Rob, 143, 287, 425, 432

columns
% Of Parent Column option (Value Field 

Settings dialog box, Show Values As tab), 
69

adding
columns to slicers, 100
columns with Power Query, 275-276
multiple subtotals to one field, 72

calculated columns, adding in Power Pivot 
grid, 281-282

categorizing columns with Power Pivot, 287
column charts in 3D Map, 292, 296
Column From Examples feature (Power 

Query), 275
empty columns in data sources, 14
filtering fields, 88
groups, repeating as columns, 13
headings, 11
hiding columns in Power Pivot, 287
labels

filtering with Values column infor-
mation, 91-92

splitting between two rows, 12
manual sort sequences, 83-84
multiple subtotals, adding to one field, 72
numeric columns, blank cells in, 24
percentage change column for year-over-

year reports, 417-419
Power Pivot

calculated columns, adding in Power 
Pivot grid, 281-282

categorizing columns with Power Pivot, 
287

hiding columns in Power Pivot, 287
renaming columns with Power Pivot, 287
sorting one column by another with 

Power Pivot, 282
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columns

Power Query
adding columns with, 275-276
column-level actions, 198-200
removing columns with Power Query 

Editor, 191
splitting columns, 204-206

rearranging, 83-84
removing columns with Power Query Editor, 

191
renaming columns with Power Pivot, 287
slicers, adding columns to, 100
sorting one column by another with Power 

Pivot, 282
splitting columns with Power Query, 204-206
subtotals (multiple), adding to one field, 72
Values columns, filtering Label columns, 91-92
widths

AutoFit, 59
vertically arranged pivot tables, 59

Columns area, 5, 22
Comments tool (VBA), 326
Compact layout, 51-53, 58, 75-76
comparing

line-to-line comparisons, Value field calcu-
lations, 66

tables with pivot tables, 400-401
compatibility

Check Compatibility tool, 7-9
pivot tables and Excel, 7-8
slicers, 7
timelines, 7
Timeline slicer, 35

conceptual filters in VBA, 374-377
conditional formatting of pivot tables

customizing rules, 168-172
example of conditional formatting, 165-167
preprogrammed scenarios, 167-168

constants and calculations, 139
converting

live pivot tables to static values (case study), 
54-55

pivot tables
to cube formulas, 232-238
to values, 338-341

copying pivot tables to workbooks, 349-350
Count Distinct, 266-267, 357
Count of Revenue bug, 62
Create PivotTable dialog box, basic pivot table 

creation
choosing report location, 20
data selection, 20
PivotTable Fields list, 21-22

creating pivot tables
basic pivot table creation, 19

adding fields to reports, 22-24
adding fields to tables, 21-24
adding layers to reports, 25
choosing report location, 20
classic pivot table layout, 26-27
creating filters, 27
data selection, 20
dragging/dropping fields in reports and 

tables, 25-26
Ideas feature, 29-30
laying out reports, 22-24, 39-40
PivotTable Fields list, 21-22
rearranging tables, 25-26
Recommended PivotTables, 28-30
slicers, 31-35

from Data Model, 283
Pivot Power Premium add-in, 45
VBA and, 330-331

adding fields to data areas, 332-333
filling blank cells in data or row area, 336
formatting tables, 333-335
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customizing

preventing errors from inserting/ 
deleting cells, 336-337

totals, 337-338
cube formulas

CUBEMEMBER function, 234
CUBERANKEDMEMBER function, 236
CUBESET function, 235-238
CUBEVALUE function, 233-236
GETPIVOTDATA function versus, 232
pivot tables, converting to cube formulas, 

232-238
SORTBY function, 238

cube functions, 248-250
CUBEMEMBER function, 234
CUBERANKEDMEMBER function, 236
cubes (OLAP)

connecting to, 239-242
dimensions of, 243
functions, 248-250
hierarchies of, 243, 257
levels of, 243
measures of, 243, 250-253
members of, 243, 250, 254-257
offline cubes, 245-247
PivotTable Fields list, 244
structure of, 242-243

CUBESET function, 235-238
CUBEVALUE function, 233-236
custom lists, sorting, 84-86, 286
custom maps (3D Map), 290
custom shapes (3D Map), 290
customers, sorting into high-to-low sequences 

based on revenue, 79-82
customizing

conditional formatting rules, 168-172
pivot tables, 44

blank cells, 47-48
blank rows, 50, 56-57

changing field names, 49
converting live pivot tables to static 

values (case study), 54-55
Count of Revenue bug, 62
default pivot tables, 44
formatting cells in Office 365, 72
grand totals, 50, 57-58
gridlines, 45
layouts, 50-53, 56-58, 75-76
subtotals, 50
number format, thousands separators, 

46-47
Pivot Power Premium add-in, 45
previewing changes with Live Preview 

feature, 60
replacing blank cells with zeros, 47-48
settings, xxiv
styles, 45, 59-62
subtotals, 50, 70-72
Value field calculations, 63-70

sort lists, 390-391
Value field calculations, 63-65

% Difference From option (Value Field 
Settings dialog box, Show Values As 
tab), 68-69

% Of option (Value Field Settings dialog 
box, Show Values As tab), 66

% Of Parent Column option (Value Field 
Settings dialog box, Show Values As 
tab), 69

% Of Parent Row option (Value Field 
Settings dialog box, Show Values As 
tab), 69

% Of Parent Total option (Value Field 
Settings dialog box, Show Values As 
tab), 69
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customizing

% Of Total option (Value Field Settings 
dialog box, Show Values As tab), 66

Index option (Value Field Settings dialog 
box, Show Values As tab), 69-70

line-to-line comparisons, 66
ranking options, 67
running total calculations, 67-68

visualizations with Power BI Desktop, 221-222

D
Dalgleish, Debra, 45
data areas

blank cells, filling in data areas, 336
fields, adding to, 332-333

data cards (tooltips), 3D Map, 296
data items, sorting in a unique sort order, 

389-390
Data Model, 330

32-bit Excel and, 287
adding

linked tables to Data Model, 279
model fields to pivot tables, 383
numeric fields to Values area, 384
tables to Data Model, 279, 381

creating, 176-179
cube formulas, converting pivot tables to, 

232-238
DAX measures and median calculations, 

269-271
Distinct Count, 266-267
Filtered Items in Totals, 269
limitations of, 180, 286-287
loading to Data Model instead of Excel grid, 

277-278
median calculations with DAX measures, 

269-271

pivot caches, 383
pivot tables

adding model fields to, 383
adding numeric fields to Values area, 

384
converting to cube formulas, 232-238
creating, 283-386

Power Query data, outputting data to Data 
Model, 193

primary keys, 177
relationships

activating, 180
creating, 178-180
creating between tables, 382
deactivating, 180
deleting, 180
editing, 180
managing, 179

tables
adding linked tables to Data Model, 279
adding to Data Model, 180, 381
creating relationships, 382
defining relationships between tables, 

279-280
text, reporting in Values area, 272
Values area, reporting text in, 272
VLOOKUP functions, replacing with Data 

Model, 261-266
data ranges

automatically expanding data ranges, 
creating, 399

writing code for, 327-328
data sets

combining in 3D Map, 297
exploding

to different tabs in pivot tables, 410-411
to different workbooks, 415-417

transposing with Power Query (case study), 
202-204
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documenting

data sources
blank cells in, 14
calculated fields, manually adding to data 

sources, 122-123
cleaning up (case study), 15-19
column headings, 11
disparate data sources

defined, 175
ETL processes, 188
external data, creating pivot tables, 

181-187
external data, defined, 175
multiple ranges, defined, 175
Power Query and, 189-193, 202

empty columns in, 14
empty rows in, 14
gaps in, 14
good design techniques, 14
refreshing

changes made to existing data sources, 
36

expanded data source ranges, 37
databases

OLAP databases, 239-240, 250-251
transactional databases, 239

date fields, grouping
by week, 110-111
including years when grouping by months, 

110
manually grouping, 108-109

Date Filters, 94-96, 101, 375
date groups, xxiv

AutoGroup feature, 344
VBA and, 344-346

DAX formulas, 285
DAX functions, xxiv

DAX measures, 139
defined, 121
median calculations, 269-271
using DAX measures instead of calculated 

fields (case study), 141-145
Debugging tool (VBA), 326
default pivot tables

behaviors, changing for future pivot tables, 
392

customizing, 44
deferring pivot table layout updates, 39-40
Delete key versus spaces, 24
deleting

calculations, 146-147
cells, preventing errors, 336-337
Data Model relationships, 180
pivot tables (underlying), pivot charts and, 162
source data worksheets, 398

dimensions of OLAP cubes, 243
disabling macros, 324
disparate data sources

defined, 175
ETL processes, 188
external data

creating pivot tables, 181-187
defined, 175

multiple ranges, defined, 175
Power Query and, 189-193, 202

Distinct Count, 266-267, 338
distributions (frequency), creating with pivot 

tables, 409-410
docking/undocking Fields list, 77
document themes, modifying styles with, 61-62
documenting

calculations, 148
formulas, 148
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Doodads rule

Doodads rule, Sort by, 82-83
dragging/dropping fields in reports, 25-26
drill-down methods, 286

E
editing

calculations, 146, 147
Data Model relationships, 180

empty cells filling in row fields, 393
Go To Special function (Excel), 395-396
Repeat All Item Labels feature, 394-395

empty columns in data sources, 14
empty rows in data sources, 14
End+Down arrow versus End+Up arrow, coding, 

328
End With and With, coding, 329
erasing pivot table layouts, 40
Escobar, Miguel, 287
ETL (Extraction, Transformation, Loading)  

processes, 188
“evil GetPivotData problem”, 426-428
Excel

32-bit Excel
Data Model and, 287
Power Pivot and, 287

Go To Special function, filling empty cells in 
row fields, 395-396

pivot tables, backward compatibility, 7, 8
versions of, 330

Excel 2019
Office 365 versus, xxix-xxx
recommended pivot tables, xxvii
ribbon, xxix-xxx
system requirements, xxxii

Excel 2019 In Depth, 306

Excel grid, loading to Data Model instead, 
277-278

Excel Help tool (VBA), 326
exploding data sets

to different tabs, 410-411
to workbooks, 415-417

external data
defined, 175
pivot tables, creating, 181

from Access (MS) data, 181-184
from SQL Server data, 184-187

extracting cells from pivot tables based on pivot 
caches, 232

extracts, creating, 3

F
February 29 1900 and Power Pivot, 286-287
Field list, Areas section drop-downs, 78-79
fields

adding to reports, 22-24
calculated fields, 286, 358-359

creating, 123-128
defined, 121
inserting into pivot tables, 124-125
manually adding to data sources, 

122-123
rules specific to, 139-140
summarizing next year’s forecast (case 

study), 129-133
using DAX measures instead of cal-

culated fields (case study), 141-145
changing names, 49
collapsing/expanding in Compact layouts, 51
column fields

adding multiple subtotals to one field, 72
filtering, 88

www.itbook.store/books/9781509307241

https://itbook.store/books/9781509307241


453

filters

data areas, adding fields to, 332-333
date fields

grouping by week, 110-111
grouping manually, 108-109
including years when grouping by 

months, 110
dragging/dropping in reports, 25-26
expanding/collapsing in Compact layouts, 51
filter fields, 369-373. See also page fields 

(VBA)
Filters area, adding fields to, 96
formatting, 14
model fields, adding to pivot tables, 383
multiple data fields, troubleshooting issues 

with, 355-356
naming fields, 49
numeric fields

adding to Values area, 384
grouping, 104-105
rank number fields, adding to pivot 

tables, 396-398
page fields (VBA), 369-373. See also filter 

fields
pivot fields

manually filtering multiple items in, 
373-374

restrictions, 413-415
PivotTable Fields list, 21-22

adding fields to tables, 24
dragging/dropping fields in tables, 

25-26
primary keys, 177
rank number fields, adding to pivot tables, 

396-398
row fields

adding multiple subtotals to one field, 
72

filling empty cells, 393-396

filtering, 88
suppressing subtotals in, 348
turning subtotals on/off in, 70-71

text fields, grouping for redistricting (case 
study), 106-108

Value field, customizing calculations, 63-70
Fields list

docking/undocking, 77
rearranging, 77-78

filling
blank cells

in data area, 336
in row area, 336

empty cells in row fields, 393
Go To Special function (Excel), 395-396
Repeat All Item Labels feature, 394-395

FILTER function, 238
filters, 32. See also slicers

3D Map, 296
AutoFiltering pivot tables, 401-404
conceptual filters in VBA, 374-377
date filters in VBA, 375
Filtered Items in Totals, 269
filter fields, 369-373. See also page fields 

(VBA)
label filters in VBA, 374
pivot fields, manually filtering multiple items 

in, 373-374
pivot tables

AutoFiltering pivot tables, 401-404
check boxes, 88-89
column fields, 88
Date Filters, 94-96
dates, filtering by, 101
Filters area, 96-97
labels, 90-96
overview of, 86-87
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filters

replicating reports for each item in a 
filter, 97-98

row fields, 88
search box, 89-90
slicers, 99-104, 378-380
Timeline slicers, 101-104
Top 10 filter, 93-94
Values columns, filtering Label columns, 

91-92
recordsets, filtering with ShowDetail (VBA), 

367-373
search filter in VBA, 377, 378
Top 10 filter, 268
value filters in VBA, 375

Filters area, 6, 22
adding fields to, 96
choosing

multiple items from a filter, 97
one item from a filter, 96

creating filters, 27
flat maps in 3D Map, 295, 296
fonts and themes, 62
forecasts, summarizing next year’s forecast  

(case study), 129-133
form controls

ActiveX controls versus, 307
defined, 306
macros, assigning to form controls, 308
scrollbars, adding to spreadsheets, 309-312
user interfaces, creating, 306-308
viewing, 307

formatting
cells in Office 365, 72
conditional formatting and pivot tables

customizing rules, 168-172
example of conditional formatting, 

165-167
preprogrammed scenarios, 167-168

fields, 14
individual values in pivot tables, 405-407
numbers

multiple number formats in pivot tables, 
404-405

thousands separators, 46-47
pivot charts, 156
pivot tables, 333-335, 350
sections of pivot tables, 407-408
slicers, 100-101

formulas
arrow keys in formula creation, 286
calculated fields, creating with formulas 

outside a pivot table, 123-124
documenting, 148
GetPivotData, preventing, 429
List Formulas command, 148

frequency distributions, creating with pivot 
tables, 409-410

functions (OLAP cube), 248-250

G
Gainer, Dave, 425
geocoding data in 3D Map, 290-291
GeoFlow. See 3D Map
GetPivotData, 425

default status, determining reasons for its, 
430-431

pivot table annoyances, solving, 431
creating shell reports, 435-436
creating ugly pivot tables, 432-435
populating shell reports, 437-440
updating shell reports, 441-442
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Insights feature and Power BI Desktop

preventing
by turning off GetPivotData, 429-430
by typing the formula, 429

problems with, 426-428
GETPIVOTDATA function

cube formulas versus, 232
extracting cells from pivot tables based on 

pivot caches, 232
Get & Transform tools, cleaning up data sources 

(case studies), 15-19
globes, using store maps instead of (case study), 

299-302
Go To Special function (Excel), empty cells, filling 

in row fields, 395-396
grand totals

calculations, grand total references, 139
controlling with VBA, 337-338
layouts, 50, 57-58

gridlines, restoring to pivot tables, 45
grouping

auto date-grouping, 75
AutoGroup

determining AutoGroup criteria, 111
using, 112
year-over-year reports, 113-115

calculating groups, 361-362
date fields

by week, 110-111
including years when grouping by 

months, 110
manually grouping, 108-109

date grouping, xxiv
numeric fields, 104-105
pivot tables, 286
repeating as columns, 13
text fields for redistricting (case study), 

106-108

H
hard data, turning pivot tables into, 393
headings

column headings, 11
section headings, storing data in, 12

heat maps in 3D Map, 294
help

Excel Help tool (VBA), 326
support/feedback, xxxii

hiding
columns with Power Pivot, 287
legends in 3D Map, 296
panes in 3D Map, 296

hierarchies, 116-118
drill-down hierarchies, 219-220
OLAP cubes, 243, 257
Power Pivot and, 287

high-to-low sequences, sorting customers in 
based on revenue, 79-82

Hoter, Dany, 238

I
Ideas feature, 29-30
images in Power BI Desktop, 212
importing

custom visualizations, Power BI Desktop, 
221-222

data to Power BI Desktop, 208
Index option (Value Field Settings dialog box, 

Show Values As tab), 69-70
individual values, formatting in pivot tables, 

405-407
Insert Slicers dialog box, 31-32
Insights command (Office 365), xxiv
Insights feature and Power BI Desktop, 224
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interactive reports

interactive reports
Power BI Desktop, creating reports with

cross-filtering charts, 218
drill-down hierarchies, 219-220
mobile phones, designing reports for, 

223
publishing to Power BI Desktop, 222
visualizations, 213-217, 221-224

showing revenue by product and time period 
(case study), 157-161

interactive web pages, workbooks as, 226-229
item labels, repeating, 52

J–K
Javelin, xxvi
Jelen, Bill, 306

L
Label columns, filtering with Values column infor-

mation, 91-92
Label Filters option, filtering with, 90-91
labeling

column labels, splitting between two rows, 12
data points in 3D Map, 294
Date Filters, 94-96
filtering, 90-91
label filters in VBA, 374
maps in 3D Map, 295
Repeat All Item Labels, 330, 394-395
repeating item labels, 52
row labels, turning on/off in Compact layout, 

58
large data files, processing with Power Query, 

273-275

latitude (3D Map), 290
layers, adding to reports, 25
layouts, 22-24

blank rows, 50, 56-57
classic pivot table layout, 26-27
Compact layout, 51-53, 58, 75-76
deferring layout updates, 39-40
grand totals, 50, 57-58
Outline layout, 52-53
subtotals, 50
Tabular layout, 12-14, 53, 75-76, 344
vertically arranging pivot tables, 59

legends (3D Map), 296
life after pivot tables (case study), xxvii-xxix
life before pivot tables (case study), xxiv-xxvi
line-to-line comparisons, Value field calculations, 

66
linked tables, adding to Data Model, 279
links, sharing to workbooks, 229
List Formulas command, 148
lists (custom), sorting, 84-86, 286
live pivot tables, converting to static values (case 

study), 54-55
Live Preview feature, 60
loading to Data Model instead of Excel grid, 

277-278
longitude (3D Map), 290
Lotus, xxvi
Lotus Improv, xxvi

M
M is for Data Monkey, 195, 287
M language

applied steps (Power Query), 194-195
viewing, 276

Macro Recorder versus Power Query, 277
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measures (DAX)

macros, 330
benefits of, 303
creating

Power Query, 313-321
VBA Macro Controller, 310-312

defined, 303
disabling, 324
enabling, 323-325
form controls, assigning macros to, 308
functionality, adding to recorded macros, 

308-309
macro recorder, 326-328
pivot table reports and, 303
recording, 304-305, 308-309
scrollbars, adding to spreadsheets, 309-312
security, 305-306
VBA Macro Controller, 310-312

managing
calculations, OLAP pivot tables, 257-258
Data Model relationships, 179
queries in Power Query, 196-198

manual sort sequences, 82, 83, 84
manually

adding calculated fields to data sources, 
122-123

grouping date fields, 108-109
maps (3D), 289

aerial photography maps, 295
animating data over time, 297-298
annotation (text boxes), 294, 299
bubble charts, 294
column charts, 292, 296
combining data sets, 297
custom maps, 290
custom shapes, 290
data cards (tooltips), 296
filters, 296

flat maps, 295-296
geocoding data, 290-291
heat maps, 294
hiding

legends, 296
panes, 296

labeling
data points, 294
maps, 295

latitude, 290
legends

hiding, 296
resizing, 296

longitude, 290
navigating maps, 292-293
pie charts, 294
preparing data for, 289
region maps, 294
relationships (table), 290
resizing legends, 296
store maps, using instead of globes (case 

study), 299-302
table relationships, 290
timelines, 298
tours, creating, 298-299
vantage point, moving, 293
video, creating, 299
zooming in/out of maps, 293

market activity analysis (case study), 35-36
McDaid, Joe, 238
MDX (Multidimensional Expressions), 250

calculated measures, 251-253
calculated members, 254-257

MDX Solutions, 251
measures (DAX), 139

defined, 121
median calculations, 269-271
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measures (DAX)

OLAP cubes, 243, 250-253
Power Pivot, 384. See also calculations
using DAX measures instead of calculated 

fields (case study), 141-145
median calculations with DAX measures, 269-271
members of OLAP cubes, 243, 250, 254-257
Merge queries, 421
mobile phones, designing interactive reports for, 

223
model fields, adding to pivot tables, 383
modifying styles with document themes, 61-62
months, grouping by, 110
mouse, manual sort sequences, 83-84
Movie PivotTable dialog box, 41
multiple data fields, troubleshooting issues with, 

355-356
multiple number formats in pivot tables, 404-405
multiple ranges, defined, 175

N
named ranges and calculations, 139
named sets, 330
naming

fields, 49
pivot tables, 33

natural language queries and Power BI Desktop, 
213

navigating maps in 3D Map, 292-293
next year’s forecast (case study), summarizing, 

129-133
number fields (rank), adding to pivot tables, 

396-398
number formats

changing in pivot tables, 347-348
multiple formats in pivot tables, 404-405
thousands separators, 46-47

numeric columns in blank cells, 24
numeric fields

adding to Values area, 384
grouping, 104-105

O
object-oriented coding

data ranges, 327-328
End+Down arrow versus End+Up arrow, 328
shortening code, 329
super-variables, 328-329
With and End With, 329

Office 365
costs of, xxxi
Excel 2019 versus, xxix-xxx
formatting cells, 72
Insights command, xxiv
new features of, xxx-xxxi
ribbon, xxx

offline cubes, creating, 245-247
OLAP (Online Analytical Processing)

cubes
connecting to, 239-242
dimensions of, 243
functions, 248-250
hierarchies of, 243, 257
levels of, 243
measures of, 243, 250-253
members of, 243, 250, 254-257
offline cubes, creating, 245-247
PivotTable Fields list, 244
structure of, 242-243

databases, 239-240, 250-251
pivot tables

adding calculations to, 250
limitations of, 244-245
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pivot table reports

managing calculations, 257-258
MDX and, 250-251
what-if analysis of OLAP data, 258-259

OneDrive workbooks, sharing links to, 229
operator precedence and calculations, 138
Outline layout, 52-53

P
page breaks, subtotals as, 350-351
page fields (VBA), 369-373. See also filter fields
percentage change column for year-over-year 

reports, 417-419
pictures of pivot charts, distributing, 163
pie charts in 3D Map, 294
pivot caches, 7, 398

cells, extracting from pivot tables based on 
pivot caches, 232

Data Model tables and, 383
defining, 383
refreshing, 6

changes made to existing data sources, 
36

expanded data source ranges, 37
sharing, 37-39

pivot charts
alternatives to, 161

deleting underlying pivot tables, 162
distributing pictures of pivot charts, 163
pivot table-linked cells as pivot chart 

source data, 163-165
turning pivot tables into hard values, 162

creating, 150-153
defined, 149
formatting limitations, 156

interactive reports showing revenue by 
product and time period (case study), 
157-161

pivot field buttons, 152-153, 160
pivot tables and

effects of changes in pivot tables on 
pivot charts, 154

placement of data fields in pivot tables 
on pivot charts, 154-156

x-axis, 155
XY scatter charts, 164-165
y-axis, 155

pivot field buttons (pivot charts), 152-153, 160
pivot fields

manually filtering multiple items in, 373-374
restrictions, 413-415

Pivot Power Premium add-in, 45
PivotTable Fields list, 21-22

fields
adding to tables, 24
dragging/dropping in tables, 25-26

OLAP cubes, 244
pivot table reports, 1

column headings, 11
layouts, 22-24

classic layout, 26-27
deferring layout updates, 39-40
starting over, 40

location of, choosing, 20
macros, 303
pivot caches, 6-7
refreshing

changes made to existing data sources, 
36

expanded data source ranges, 37
size of, reducing, 398
snapshots, 6
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pivot tables

pivot tables, 1
anatomy of

Columns area, 5
Filters area, 6
Rows area, 5
Values area, 4

annoyances, solving with GetPivotData, 
431-432
creating shell reports, 435,-436
creating ugly pivot tables, 432-435
populating shell reports, 437-440
updating shell reports, 441-442

basic creation, 19
adding fields to reports, 22-24
adding layers to reports, 25
choosing report location, 20
classic pivot table layout, 26-27
creating filters, 27
data selection, 20
dragging/dropping fields in reports, 

25-26
Ideas feature, 29-30
laying out reports, 22-24, 39-40
PivotTable Fields list, 21-26
rearranging tables, 25-26
Recommended PivotTables, 28-30
slicers, 31-35

blank cells, deleting, 346-347
calculated data fields, 358-359
calculated items, 359-361
calculating groups, 361-362
calculating with, 355

Show Values As tab (Value Field Settings 
dialog box), 362-363

VBA calculation options per Excel 
version, 364

calculation functions, 356-358

cells
blank cells, deleting, 346-347
extracting from pivot tables based on 

pivot caches, 232
Columns area, 5, 22
comparing tables with, 400-401
conditional formatting

customizing rules, 168-172
example of, 165-167
preprogrammed scenarios, 167-168

converting live tables to static values (case 
study), 54-55

copying as values to workbooks, 349-350
creating. See also basic pivot table creation

from Data Model, 283
Pivot Power Premium add-in, 45
VBA and, 330-338

cube formulas, converting pivot tables to, 
232-238

custom lists, sorting, 286
customizing, 44

blank cells, 47-48
blank rows, 50, 56-57
changing field names, 49
converting live pivot tables to static 

values (case study), 54-55
Count of Revenue bug, 62
default pivot tables, 44
formatting cells in Office 365, 72
grand totals, 50, 57-58
gridlines, 45
layouts, 50-53, 56-58, 75-76
subtotals, 50
number format, thousands separators, 

46-47
Pivot Power Premium add-in, 45
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pivot tables

previewing changes with Live Preview 
feature, 60

replacing blank cells with zeros, 47-48
settings, xxiv
styles, 45, 59-62
subtotals, 50, 70-72
Value field calculations, 63-70

Data Model
adding model fields to, 383
adding numeric fields to Values area, 

384
creating pivot tables, 283, 383-386

data sets, exploding
to different tabs, 410-411
to different workbooks, 415-417

date groups and VBA, 344-346
default behaviors, changing for future pivot 

tables, 392
default settings, xxiv
development of, xxvi
distributions (frequency), creating, 409-410
Excel backward compatibility, 7, 8
extracts, creating, 3
filters

AutoFiltering pivot tables, 401-404
creating, 27
Filters area, 6, 22, 27

formatting, 333-335
individual values in pivot tables, 

405-407
multiple number formats in pivot tables, 

404-405
sections of pivot tables, 407-408
VBA and, 350

frequency distributions, creating, 409-410

GetPivotData, solving annoyances with, 
431-432
creating shell reports, 435-436
creating ugly pivot tables, 432-435
populating shell reports, 437-440
updating shell reports, 441-442

grouping, 286
hard data, turning pivot tables into, 393
Ideas feature, 29-30
life after (case study), xxvii-xxix
life before (case study), xxiv-xxvi
live tables, converting to static values (case 

study), 54-55
limitations of, 7
Move PivotTable dialog box, 41
multiple data fields, troubleshooting issues 

with, 355-356
naming, 33
new features, xxiii-xxiv
number fields (rank), adding to pivot tables, 

396-398
number format

changing, 347-348
multiple number formats in, 404-405

OLAP pivot tables
adding calculations to, 250
limitations of, 244-245
managing calculations, 257-258
MDX and, 250-251
what-if analysis of OLAP data, 258-259

page breaks, subtotals as, 350-351
product calculations, 286
rank number fields, adding to pivot tables, 

396-398
rearranging, 25-26
Recommended PivotTables, xxvii, 28-30
refreshing, 431
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pivot tables

all pivot tables in a workbook at the 
same time, 388

automatically refreshing, 388
relocating, 41
restrictions, 412-413
Rows area, 5, 22
slicers

connecting to multiple pivot tables, 
32-33

standard slicers, 31-33
Timeline slicer, 34-35

sort order, controlling with AutoSort, 347
sorting

custom lists, 390-391
unique sort order, 389-390

static values (case study), converting live 
tables to, 54-55

subtotals
as page breaks, 350-351
suppressing for multiple row fields, 348

Tabular layouts and VBA, 344
ugly pivot tables, creating, 432-435
updates, xxxii
usage examples, 2, 3
Values area, 4, 22
VBA

AutoShow and executive overviews, 
365-367

calculating with pivot tables, 355-364
changing default number format, 

347-348
conceptual filters, 374-377
controlling sort order with AutoSort, 347
converting to values, 338-341
copying as values to workbooks, 

349-350
creating pivot tables, 330-338

creating reports for each region/model, 
369-373

creating revenue by category reports, 
341-344

date filters, 375
date groups, 344-346
deleting blank cells, 346-347
filtering recordsets with ShowDetail, 

367-373
formatting pivot tables, 350
label filters, 374
manually filtering multiple items in pivot 

fields, 373-374
search filter, 377-378
slicers, filtering pivot tables, 378-380
subtotals as page breaks, 350-351
summary reports, producing, 352-354
suppressing subtotals for multiple row 

fields, 348
Tabular layouts, 344
value filters, 375

versions of, 330
workbooks, copying pivot tables to, 349-350

Power BI Custom Visuals, 173-174
Power BI Desktop, xxiv, 207

cross-filtering charts, 218
drill-down hierarchies, 219-220
Excel, preparing data in, 208
images in, 212
importing data to, 208
Insights feature, 224
interactive reports, creating

creating visualizations, 213-217
cross-filtering charts, 218
designing reports for mobile phones, 

223
drill-down hierarchies, 219-220
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Power Query

importing custom visualizations, 
221-222

publishing to Power BI Desktop, 222
publishing to workspaces, 223-224

natural language queries, 213
navigating, 209-210
preparing data in, 210-212
publishing to, 222
Q&A feature, 225-226
querying data, 225-226
relationships, 210-213
setting up, 207
signing in, 207
synonyms, defining, 213
visualizations, 209

creating, 213-217
importing custom visualizations, 

221-222
workspaces, publishing to, 223-224

Power Map. See 3D Map
Power Pivot, xxiv, 261

32-bit Excel and, 287
benefits of, 287
columns

calculated columns, adding in Power 
Pivot grid, 281-282

categorizing, 287
hiding, 287
renaming, 287
sorting one column by another, 282

Data Model
adding model fields to pivot tables, 383
adding numeric fields to Values area, 

384
adding tables to, 381
creating pivot tables, 383-386

creating relationships between tables, 
382

defining pivot caches, 383
February 29 1900, 286-287
hierarchies, 116-118, 287
limitations of, 286-287
measures, 384. See also calculations
pivot tables, creating from Data Model, 283
relationships, 284
time intelligence, 285
using DAX measures instead of calculated 

fields (case study), 143
Power Pivot and Power BI, 287
Power Pivot Data Model, 330
Power Pivot for the Data Analyst, 282
Power Query

Advanced Query Editor, 195
applied steps, 194-195, 276
big data files, processing, 273-275
cleaning up data sources (case studies), 15-19
columns

adding, 275-276
Column From Examples feature, 275
column-level actions, 198-200
removing, 191
splitting, 204-206

connection types, 202
ETL processes, 188
installing, 188
M language

applied steps, 194-195
viewing, 276

macros, creating, 313-321
managing queries, 196-198
outputting data to Data Model, 193
Power Query Editor, cleaning up data sources 

(case studies), 16
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Power Query

previewing data, 190
queries

managing, 196-198
starting, 188-190

refreshing data, 196
removing columns, 191
splitting

columns, 204-206
rows, 204-206

table actions, 200-201
transforming data, 190-192
transposing data sets (case study), 202-204
two-way VLOOKUP, 419-424
VBA Macro Recorder versus, 277

Power View, xxiv
previewing changes with Live Preview feature, 60
primary keys, 177
product calculations, 286
Project Explorer (Visual Basic Editor), 325
properties (VBA coding), 327
Properties window (Visual Basic Editor), 326
publishing

interactive reports to workspaces, 223-224
to Power BI Desktop, 222

Puls, Ken, 195, 287

Q
Q&A feature and Power BI Desktop, 225-226
queries

managing queries with Power Query, 196-198
Merge queries, 421
natural language queries, 213
Power BI Desktop

natural language queries, 213
querying data with Q&A feature, 

225-226

starting queries with Power Query, 188-190
web queries (Power Query)

Advanced Query Editor, 195
applied steps, 194-195
column-level actions, 198-200
connection types, 202
ETL processes, 188
installing, 188
managing queries, 196-198
outputting data to Data Model, 193
previewing data, 190
refreshing data, 196
removing columns, 191
splitting columns/rows, 204-206
starting queries, 188-190
table actions, 200-201
transforming data, 190-192
transposing data sets (case study), 

202-204

R
ranges

multiple ranges, defined, 175
named ranges and calculations, 139

rank number fields, adding to pivot tables, 
396-398

ranking, Value field calculations, 67
rearranging

columns, 83-84
Fields list, 77-78
pivot tables, 25, 26

Recommended PivotTables, xxvii, 28-30
redistricting, grouping text fields for (case study), 

106-108
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reports

references and calculations
cell references, 139
totals, 139

refreshing
data in Power Query, 196
data sources

changes made to existing data sources, 
36

expanded data source ranges, 37
pivot caches, 6

changes made to existing data sources, 
36

expanded data source ranges, 37
pivot table reports

changes made to existing data sources, 
36

expanded data source ranges, 37
pivot tables, 431

all pivot tables in a workbook at the 
same time, 388

automatically refreshing, 388
slow refreshes, 286

region maps in 3D Map, 294
relationships

3D Map table relationships, 290
Data Model

activating relationships, 180
creating relationships, 178-180
deactivating relationships, 180
deleting relationships, 180
editing relationships, 180
managing relationships, 179
tables, 279-280, 382

Power BI Desktop, 210-213
Power Pivot and, 284
tables, defining relationships between tables 

with Data Model, 279-280

relocating pivot tables, 41
removing columns with Power Query Editor, 191
renaming columns with Power Pivot, 287
re-ordering items, 286
Repeat All Item Labels, 330, 394-395
repeating

groups as columns, 13
item labels, 52

replicating reports for each item in a filter, 97-98
report layouts, 50

blank rows, 50, 56, 57
Compact layout, 51, 53, 75, 76

turning row labels on/off, 58
grand totals, 50, 57, 58
Outline layout, 52, 53
subtotals, 50
Tabular layout, 53, 75, 76

reports
filters, replicating reports for each item in a, 

97-98
interactive reports, creating with Power BI 

Desktop
creating visualizations, 213, 214, 215, 217
cross-filtering charts, 218
designing reports for mobile phones, 

223
drill-down hierarchies, 219, 220
importing custom visualizations, 221, 

222
publishing to Power BI Desktop, 222
publishing to workspaces, 223, 224

layouts
blank rows, 50, 56-57
Compact layout, 51-53, 58, 75-76
grand totals, 50, 57-58
Outline layout, 52-53
subtotals, 50
Tabular layout, 53, 75-76
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reports

macros, 303
replicating reports for each item in a filter, 

97-98
revenue by category reports, creating, 

341-344
shell reports

creating, 435-436
populating, 437-440
updating, 441-442

size of, reducing, 398
summary reports, producing, 352-354
Top 5 Markets reports, 365-367
top-five reports, creating with Top 10 filter, 

93-94
VBA, creating reports for each region/model, 

369-373
year-over-year reports

creating, 113-115
percentage change column and, 417-419

requirements (system), xxxii
resizing legends (3D Map), 296
restrictions

pivot fields, 413-415
pivot tables, 412-413

revenue
interactive reports showing revenue by 

product and time period (case study), 
creating, 157-161

revenue by category reports, creating, 
341-344

sorting customers into high-to-low sequences 
based on revenue, 79-82

ribbon
Excel 2019, xxix-xxx
Office 365, xxx

rows
% Of Parent Row option (Value Field Settings 

dialog box, Show Values As tab), 69

blank cells, filling in row area, 336
blank rows (layouts), 50, 56-57
column labels, splitting between two rows, 12
empty cells, filling, 393

Go To Special function, 395-396
Repeat All Item Labels feature, 394-395

empty rows in data sources, 14
filtering fields, 88
labels, turning on/off in Compact layout, 58
multiple row fields, suppressing subtotals in, 

348
splitting with Power Query, 204-206
subtotals

adding multiple subtotals to one field, 
72

suppressing for multiple row fields, 348
turning on/off in row fields, 70,-71

Rows area, 5, 22
running total calculations, Value field calculations, 

67-68

S
Salas, Pito, xxvi
scatter charts, 164-165
scrollbars, adding to spreadsheets, 309-312
search box, filtering with, 89-90
search filter in VBA, 377-378
section headings, storing data in, 12
security

macros, 305-306
trusted locations, 306

shapes (custom) in 3D Map, 290
sharing

links to workbooks, 229
pivot caches, 37-39
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store maps

shell reports
creating, 435-436
populating, 437-440
updating, 441-442

ShowDetail (VBA), filtering recordsets, 367-369
ShowPages (VBA), 370
Show Values As tab (Value Field Settings dialog 

box), 65
% Difference From option, 68-69
% Of option, 66
% Of Parent Column option, 69
% Of Parent Row option, 69
% Of Parent Total option, 69
% Of Total option, 66
Index option, 69-70
performing calculations with, 362-363
ranking options, 67
running total calculations, 67-68

size of pivot table reports, reducing, 398
slicers, 330. See also filters

columns, adding to slicers, 100
compatibility, 7
filtering with, 99-101, 378-380
formatting, 100-101
Insert Slicers dialog box, 31-32
multiple pivot tables

connecting to, 32-33
driving from, 102-104

slicing the measures, 243
standard slicers, creating, 31-33
Timeline slicers, 101

compatibility, 35
creating, 34-35
driving multiple tables from, 102-104
interactive reports showing revenue 

by product and time period (case 
study), creating, 158-159

snapshots
pivot caches, refreshing, 6
pivot table reports, 6

solve order of calculated items, changing, 147
Sort by Doodads rule, 82-83
SORTBY function, 238
sorting

custom lists, 286
data items, unique sort order, 389-390
one column by another with Power Pivot, 282
pivot tables

custom lists, 84-86, 390-391
manual sort sequences, 82-84
Sort by Doodads rule, 82-83
sorting customers into high-to-low se-

quences based on revenue, 79-82
unique sort order, 389-390

sort order, controlling with AutoSort, 347
source data worksheets, deleting, 398
spaces

as text, 24
Delete key versus, 24

splitting
columns

labels between two rows, 12
columns with Power Query, 204-206

rows with Power Query, 204-206
Spofford, George, 251
spreadsheets, adding scrollbars to, 309-312
SQL Server, creating pivot tables from SQL Server 

data, 184-187
standard slicers, creating, 31-33
starting over, pivot table layouts, 40
static values, converting live pivot tables to (case 

study), 54-55
store maps, using instead of a globe (case study), 

299-302
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store maps

storing data in section headings, 12
styles

creating, 60
customizing, 60
modifying with document themes, 61-62
pivot table styles, 59

applying, 45
creating styles, 60
customizing styles, 60
modifying with document themes, 

61-62
subtotals, 50

calculations, subtotal references, 139
controlling with VBA, 337-338
multiple subtotals, adding to one field, 72
page breaks, 350-0351
row fields, turning subtotals on/off in, 70-71

Sum, Count of Revenue bug, 62
SUMIFS function, xxv-xxviii
summarizing next year’s forecast (case study), 

129-133
summary reports, producing, 352-354
SUMPRODUCT function. See SUMIFS function
Supercharge Excel, 287
super-variables, coding, 328-329
support/feedback, xxxii
synonyms, defining in Power BI Desktop, 213
system requirements, xxxii

T
tables

adding to Data Model, 180
Data Model

adding tables to, 180
defining relationships, 279-280
linked tables in, 279

pivot tables, comparing with, 400-401
Power Query, table actions, 200-201
relationships

3D Map relationships, 290
defining with Data Model, 279-280

styles, applying, 45
Tabular layout, 12-14, 53, 75-76, 344
text

spaces as, 24
Values area, reporting text in, 272

text boxes (annotation) in 3D Map, 294, 299
text fields, grouping for redistricting (case study), 

106-108
themes

document themes, modifying styles with, 
61-62

fonts, 62
thousands separators (number format), 46-47
time intelligence (Power Pivot), 285
Timeline slicers, 101

compatibility, 35
creating, 34-35
driving multiple tables from, 102-104
interactive reports showing revenue by 

product and time period (case study), 
creating, 158-159

timelines
3D Map tours, 298
compatibility, 7

tooltips (data cards) in 3D Maps, 296
Top 5 Markets reports, 93-94, 365-367
Top 10 filter, 93-94, 268
totals

calculations, referencing in, 139
Filtered Items in Totals, 269
pivot tables, controlling totals, 337-338

tours (3D Map), creating, 298-299
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VBA (Visual Basic for Applications)

transactional databases, 239
transposing data sets with Power Query (case 

study), 202-204
Trust Center, enabling macros, 323-324
trusted locations, 306
turning on/off

GetPivotData, 429-430
row labels in Compact layout, 58
subtotals in row fields, 70-71

two-way VLOOKUP, 419-424

U
ugly pivot tables, creating, 432-435
undocking/docking Fields list, 77
unique sort orders, 389-390
updates, xxxii

pivot caches
changes made to existing data sources, 

36
expanded data source ranges, 37

pivot table updates, deferring, 39-40
shell reports, 441-442
slow refreshes, 286

user interfaces
creating with form controls, 306-308
defined, 306

V
Value field, customizing calculations, 63-65

% Difference From option (Value Field 
Settings dialog box, Show Values As tab), 
68-69

% Of option (Value Field Settings dialog box, 
Show Values As tab), 66

% Of Parent Column option (Value Field 
Settings dialog box, Show Values As tab), 
69

% Of Parent Row option (Value Field Settings 
dialog box, Show Values As tab), 69

% Of Parent Total option (Value Field Settings 
dialog box, Show Values As tab), 69

% Of Total option (Value Field Settings dialog 
box, Show Values As tab), 66

Index option (Value Field Settings dialog box, 
Show Values As tab), 69-70

line-to-line comparisons, 66
performing calculations with, 362-363
ranking options, 67
running total calculations, 67-68

values
filters in VBA, 375
pivot tables, converting to, 54-55, 338-341

Values area, 4, 22
fields, changing names, 49
text, reporting in, 272

Values columns, filtering Label columns, 91-92
vantage point (3D Map), moving, 293
VBA (Visual Basic for Applications)

AutoComplete tool, 326
AutoShow, executive overviews of pivot 

tables, 365-367
coding, properties, 327
Comments tool, 326
conceptual filters, 374-377
date filters, 375
Debugging tool, 326
enabling, 323-324
Excel Help tool, 326
label filters, 374
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VBA (Visual Basic for Applications)

Macro Controller
macros, creating, 310-312
scrollbars, adding to spreadsheets, 

310-312
Macro Recorder versus Power Query, 277
object-oriented coding

data ranges, 327-328
End+Down arrow versus End+Up arrow, 

328
shortening code, 329
super-variables, 328-329
With and End With, 329

page fields, 369-373. See also filter fields
pivot fields, manually filtering multiple items 

in, 373-374
pivot tables

changing default number format, 
347-348

converting to values, 338-341
copying as values to workbooks, 

349-350
date groups, 344-346
deleting blank cells, 346-347
formatting, 350
producing summary reports, 352-354
sort order, controlling with AutoSort, 

347
revenue by category reports, 341-344
subtotals as page breaks, 350-351
subtotals, suppressing for multiple row 

fields, 348
Tabular layouts, 344

pivot tables, advanced techniques
AutoShow and executive overviews, 

365-367
conceptual filters, 374-377
creating reports for each region/model, 

369-373

date filters, 375
filtering recordsets with ShowDetail, 

367-373
label filters, 374
manually filtering multiple items in pivot 

fields, 373-374
search filter, 377-378
slicers, filtering pivot tables, 378-380
value filters, 375

pivot tables, calculating with
calculated data fields, 358-359
calculated items, 359-361
calculating groups, 361-362
calculation functions, 356-358
Show Values As tab (Value Field Settings 

dialog box), 362-363
troubleshooting issues with multiple 

data fields, 355-356
VBA calculation options per Excel 

version, 364
pivot tables, creating, 330-331

adding fields to data areas, 332-333
filling blank cells in data or row area, 336
formatting tables, 333-335
preventing errors from inserting/de-

leting cells, 336-337
totals, 337-338

reports, creating for each region/model, 
369-373

search filter, 377-378
ShowDetail, filtering recordsets, 367-369
ShowPages, 370
slicers, filtering pivot tables, 378-380
summary reports, producing, 352-354
value filters, 375
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workbooks

Visual Basic Editor
Code window, 326
Project Explorer, 325
Properties window, 326

vertically arranging pivot tables, 59
video, creating with 3D Map, 299
Visual Basic Editor

Code window, 326
Project Explorer, 325
Properties window, 326

visualizations
customizing with Power BI Desktop, 221-222
pivot charts

alternatives to, 161-165
creating, 150-153
creating interactive reports showing 

revenue by product and time period 
(case study), 157-161

defined, 149
effects of changes in pivot tables on 

pivot charts, 154
formatting limitations, 156
pivot field buttons, 152-153, 160
placement of data fields in pivot tables 

on pivot charts, 154-156
x-axis, 155
XY scatter charts, 164-165
y-axis, 155

Power BI Custom Visuals, 173-174
Power BI Desktop, 209

creating visualizations, 213-217
importing custom visualizations, 

221-222
VLOOKUP, 206

Data Model, replacing with, 261-266
two-way VLOOKUP, 419-424

W
web pages (interactive),workbooks as, 226-229
web queries (Power Query)

Advanced Query Editor, 195
applied steps, 194-195
column-level actions, 198-200
connection types, 202
ETL processes, 188
installing, 188
managing queries, 196-198
outputting data to Data Model, 193
previewing data, 190
refreshing data, 196
removing columns, 191
splitting columns/rows, 204-206
starting queries, 188-190
table actions, 200-201
transforming data, 190-192
transposing data sets (case study), 202-204

weeks, grouping date fields by, 110-111
what-if analysis, OLAP pivot table data, 258-259
widths (columns)

AutoFit, 59
vertically arranged pivot tables, 59

With and End With, coding, 329
workbooks

data sets, exploding to different workbooks, 
415-417

interactive web pages, workbooks as, 226-229
macros, enabling, 325
pivot tables

copying pivot tables to, 349-350
refreshing all pivot tables at the same 

time, 388
sharing links to, 229
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worksheets

worksheets
functions and calculations, 139
source data worksheets, deleting, 398

workspaces, publishing interactive reports to, 
223-224

X
x-axis (pivot charts), 155
.xls file format, enabling macros, 325
.xlsb file format, enabling macros, 325
.xlsm file format, enabling macros, 325
XY scatter charts, 164-165

Y
y-axis (pivot charts), 155
year-over-year reports

creating, 113-115
percentage change column and, 417-419

years
including when grouping by months, 110
summarizing next year’s forecast (case study), 

129-133

Z
zeros, replacing blank cells with, 47-48
zooming in/out of maps in 3D Map, 293
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